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Dear Faculty,

Welcome to the start of another great year at Humber College. On behalf of the executive and 
administrative teams, I would like to extend a warm welcome to you all. I am sure that you are all looking 
forward to an incredibly productive, creative and rewarding semester at Humber. 

Humber has a 48-year history and commitment to providing high-quality postsecondary education. 
Today, the college offers over 350 programs and serves more than 27,000 full-time and 56,000 part-time 
student registrations across eight academic schools and at three campuses: North Campus including 
Guelph-Humber, Lakeshore Campus and Orangeville. We are a very diverse community that is dedicated to 
student success, and teaching and learning excellence.

Each of our programs is designed to meet the needs and vocational interests of our students. 
However, our students can only excel when you, the faculty, create a supportive and dynamic learning 
environment that places student success at the centre of your teaching practice. You play a pivotal 
role in creating a rich academic experience for students through your commitment to using the latest 
technology and teaching methodologies in state-of-the-art labs and classrooms that simulate a real-
world working environment.

This handbook is designed to help you become familiar with the facilities and resources available to 
support you as a faculty member at Humber as well as some of our key policies and procedures that we 
feel will help contribute to and enrich your experience teaching at Humber. My hope is that the information 
contained within these pages will answer many of your questions, but please feel free to ask for additional 
assistance when needed, from any of the individuals listed in this handbook. Our doors are always open, 
so please do not hesitate to share your successes with us, no matter how small.

I wish you all the best as you begin your teaching career at Humber and thank you for your dedication to 
our students and their academic success. 

Chris Whitaker 
President and CEO 
Humber Institute of Technology & Advanced Learning

WElComE lETTEr
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ABouT HumBEr
Humber, a member of Polytechnics Canada, is 
committed to student success through excellence 
in teaching and learning. Humber’s broad range 
of career-focused credentials include bachelor 
degrees, diplomas, certificates, apprenticeships 
and postgraduate certificates. With 160 full-time 
programs and 200 continuing education programs 
to choose from, Humber students have access to 
many opportunities for continuous learning.

Values:

Student-Centred – We hold the current and future 
success of our students as our highest priority.

Excellence – We are committed to outstanding 
services, academic programs and teaching.

Innovation – We anticipate and respond to 
emerging trends to meet the evolving needs of our 
local, national and global communities.

respect – We uphold the highest ethical 
standards, and affirm and protect the rights, 
dignity and integrity of each member of our 
diverse community.

Inclusion – We cultivate a working and learning 
environment where diversity is recognized as 
essential to our success.

Sustainability – We preserve our collective future 
by embracing the social, ecological and economic 
impact of our decisions.

Vision: 
Leadership in Polytechnic Education

mission:

Humber develops broadly educated, highly skilled 
and adaptable citizens to be successful in careers 
that significantly contribute to the communities 
they serve – locally, nationally and globally.
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President & CEo 

Chris Whitaker

Vice-President, 
Student and Community 

Engagement  

Jason Hunter

Vice-President, 
Advancement and 
External Affairs 

Alister Mathieson

Senior Vice President, 
Academic 

 

Laurie Rancourt

Vice-President, 
Human resources 

 

Lori A. Diduch  

Senior Vice President, 
Planning and Corporate 

Services, and Cfo 

Rani Dhaliwal

2015-16 SEnIor 
lEADErSHIP TEAm
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CEnTrE for TEACHIng & 
lEArnIng
The Centre for Teaching & Learning (CTL) is 
dedicated to the development and enhancement 
of teaching and learning practices across the 
institution.

The Centre is both proud and excited to offer a 
forum for the sharing of information; to energize 
and mobilize innovative teaching practices; to 
support the vision of Humber as a leader in 
polytechnic education; to fulfill the mission of 
Humber to develop broadly educated, highly 
skilled and adaptable citizens locally, nationally 
and globally. The following descriptions provide a 
glimpse into just a few of the many training and 
development opportunities available to faculty.

TEACHIng ExCEllEnCE ProgrAm

The Teaching Excellence Program is a two-year 
intensive program designed to support faculty as 
they transition into their full-time teaching roles. 
The program includes a three-day residential 
opportunity, action learning, mentorship, a variety 
of learning events that explore the theory and the 
application of teaching and learning, as well as 
educational and research opportunities to support 
leadership development.

TEACHIng EffECTIVEnESS ProgrAm

The Teaching Effectiveness Certificate program 
is designed for those interested in the field of 
teaching or private sector training. The courses 
within this certificate program provide participants 
with an opportunity to explore best practices in 
teaching and learning. Participants learn and 
apply the skills taught in a safe environment with 
other classmates.

The certificate is comprised of five individual 
courses that are designed to develop essential 
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teaching competencies. Each course is delivered 
over two or three Saturdays (9:30 a.m. – 3:30 p.m.) 
and is also available online.  Register online: 
http://www.humber.ca/continuingeducation/

Culturally Inclusive Educator Certificate

The program is composed of five key areas that 
are designed to develop essential teaching and 
learning competencies for supporting international 
students in higher education.

CIEC is offered in the fall, winter, or spring/
summer semesters for full-time, and part-time 
faculty and training professionals. Each of the 
five courses is offered in a blended format with 
in class sessions on Wednesdays (6:00 – 8:30 
p.m.). Register online: http://www.humber.ca/
continuingeducation/

ProgrAmS AnD WorkSHoPS

The CTL offers over 500 workshops and training 
programs throughout the academic year. These 
programs and workshops are presented in a 
variety of forums, days and times to support both 
full-time and part-time teaching schedules. These 
training opportunities include expert panels, 
demonstrations, keynote speakers, hands-on 
workshops and learning events designed to 
support networking and best practices. For 
a full listing of training, please browse our 
calendar online at: http://www.humber.ca/
centreforteachingandlearning/
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SHArIng Your BEST PrACTICES

Sharing your best teaching and learning practices 
with colleagues is a long-time Humber tradition. 
Together, faculty have made Humber a pre-
eminent teaching institution.

CoACHIng

The CTL provides coaching and mentoring to 
support and develop a full range of teaching 
abilities. If you are interested in getting a coach  
or being a coach, please contact the CTL at  
Ext. 5040 or email Denise Gardner  
Denise.gardner@humber.ca.

You Too Can Contribute 
Do you have a great idea for a workshop or 
development opportunity? Do you have a best 
practice that you would like to share? 

Submit your ideas to Denise Gardner  

Denise.gardner@humber.ca

InDIVIDuAl ConSulTATIon on TEACHIng AnD 
lEArnIng

Consulting services are also available on a 
one-on-one basis. Support is provided on issues 
related to teaching and learning, instructional 
design and the use of educational technology.

ConfErEnCES

The CTL provides faculty with the opportunity 
to explore best practices, to learn new teaching 
and learning methodologies, and to network and 
share ideas with peers at three different in-house 
conferences.

The Continuing Education (CE) and Part-time 
faculty Appreciation Day is designed to support 
and advance learning for our CE and part-time 
faculty. This is an opportunity for Humber to 
provide both development and recognition of 
these great teachers. October 20, 21, 2015.
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The Part-time mini Conference provides an 
opportunity for part-time faculty to listen and learn 
from both industry experts as well as to receive 
guidance and mentorship from full-time faculty in 
regard to their teaching practice. April 2, 2016.

Showcase is Humber’s year-end faculty 
celebration. Most notable is the opportunity for 
faculty to showcase their teaching and learning 
innovations, as well as the opportunity to be 
inspired by their peers.

HumBEr PrESS

Humber Press is a scholarly press that originated 
in the 1970s and was relaunched in 2013. 
The purpose of the press is to disseminate the 
knowledge, research, scholarship and creativity of 
Humber’s faculty, students and interested writers. 
It offers encouragement and support and provides 
an outlet for participation in the wider academic 
and professional community through publishing. 
http://humberpress.com/

ToolS, rESourCES AnD TEmPlATES

The CTL has built an extensive repository of 
teaching tools, resources and templates. Access 
is available through http://www.humber.ca/
centreforteachingandlearning

HumberCTl YouTube Channel

The HumberCTL YouTube Channel is designed to 
celebrate our success stories, learning events, and 
teaching practices. Learn from other faculty as they 
share new and innovative teaching techniques, 
study established best practices and future trends 
in postsecondary instruction, and watch as real 
students praise their favourite teachers for the 
exceptional learning experiences they have 
received. The HumberCTL YouTube channel provides 
a medium for our faculty to work as one, ensuring 
that our students receive only the best in 
postsecondary education. Be sure to subscribe to 
the HumberCTL YouTube channel at: 

http://youtube.com/HumberCTl
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HumberEDu YouTube Channel

The HumberEDU YouTube Channel enables open 
access to engaging educational content, created 
by some of Humber’s most creative faculty. Have 
you created educational videos that are not 
featured on HumberEDU? We’d love to hear from 
you! Send us an email at edu@humber.ca.

Subscribe to HumberEDU by visiting:  
http://www.youtube.com/HumberEDu

21ST-CEnTurY TEACHIng

While firmly founded on proven teaching and 
learning principles, the Centre has a keen eye 
on the challenges posed in creating quality 
higher education learning experiences. Our future 
teachers must be attuned to the connected 
generation they teach by being agile with 
technology, credible in the digital world, and 
entrepreneurial in spirit while still engaged and 
available at the traditional classroom level. The 
CTL, through all of its many activities listed above, 
is committed to providing the fertile ground for the 
21st-century teacher to thrive.

lEAguE for InnoVATIon In THE CommunITY 
CollEgE

Humber College is a proud member of a group of 
vanguard colleges with membership in the League 
for Innovation. Every year the League honours 
outstanding innovations that have been 
recognized by member institutions as Innovations 
of the Year. These innovations represent faculty 
and staff achivements that advance learning 
throughout the insitution. It is also an opportunity 
for peers to recognize college employees who have 
designed and implemented significant innovations 
that positively impact the education of students at 
Humber. Employees from all employee groups (full 
and part-time faculty, administrators, and support 
personnel) are eligible for nomination. Peers 
submit nominations to the President. To see the 
2015 League for Innovation Awards Winners, go 
to: http://youtube.com/HumberCTl
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TEACHIng AnD lEArnIng InnoVATIon funD

Humber advocates faculty involvement in 
teaching and learning innovations through the 
CTL. Assistance can be given in the form of seed 
funds, time and/or other means of support. 
Experimentation in teaching is encouraged.

CASE TEACHIng AnD WrITIng SErVICES

Want to bring the world of work into your 
classrooms? Want to engage your students in 
deep learning methods?

Through three-day case teaching and five-day 
writing workshops in the CTL, faculty can learn 
how to adapt the Case Study Method traditionally 
used in MBA programs to teaching at Humber 
and reap the benefits of using cases to stimulate 
critical thinking while allowing students to 
apply new concepts immediately to real-world 
situations. Faculty will discover how to mine 
industry contacts for engaging cases that can be 
used as teaching tools to get students to apply 
their learning.

The case writing workshop guides participants 
through the process of writing a case, from 
selecting an appropriate contact to conducting the 
interview(s) and shaping the narrative of the case 
to fit particular learning objectives. The case is 
also prepared for publication with a teaching note.

Are you already proficient using the case method? 
Access a variety of cases for use in Humber 
Programming at Humber Press  
http://humberpress.com/

For more information, please contact the CTL at 
Ext. 5040. 
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Humber recognizes the potential learning 
opportunities attained through engagement with 
our international community. Resources are 
available through the CTL to help faculty make the 
transition for international students a positive 
experience. One-on-one consultations and various 
workshops dealing with the behaviours and 
feelings that may accompany students through the 
stages of adjustment are offered throughout the 
year. Research and examination of learning styles 
of international students is available and can be 
used by faculty to set up classroom experiences 
to build trust and facilitate communication 
between all students. Information and suggestions 
can also be found on the CTL website in the form 
of video presentations.  

http://humber.ca/
centreforteachingandlearning/  

or on CTL’s YouTube Channel: 
 http://youtube.com/HumberCTl

For more information, please contact the CTL at 
Ext. 5040.

TEACHIng AnD lEArnIng EVIDEnCE-BASED 
PrACTICE AnD rESEArCH

A qualified resource person in the CTL provides 
a sounding board to faculty to assist in helping 
to frame ideas and questions about Teaching 
and Learning project possibilities to enhance 
the quality of our students’ learning experiences, 
to improve teaching and learning quality, to 
evaluate teaching strategies that are already in 
use in the classroom, to assess and measure 
the impact of learning approaches, qualitatively 
and quantitatively, to pilot innovative and flexible 
learning approaches for engaging students and 
faculty, and finally to help with graduate studies.

For more information, please contact the CTL at 
Ext. 5040. or email Heidi Marsh Heidi.marsh@
humber.ca

InTErnATIonAlIzIng CurrICulum

How do we provide opportunities for our 
students to transform through the stages of 
intercultural competence in the classroom? 
Take time to assess your own identity and 
translate that awareness and understanding into 
reflective action.
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THE CTl CrEATIVE STuDIo

Crafted for innovation and creativity, the Creative 
Studio is centered at the intersection of education 
and imagination. Our commitment is towards 
advancing the state of postsecondary scholarship, 
and merging it with the best in creative 
technology. We offer support to faculty using 
teaching technologies in the creation of content. 
The studio has all the ingredients needed to 
produce outstanding videos to share online or 
display in the class. In addition to supporting the 
production of course content for faculty, we also 
turn the cameras on the teaching process itself, 
interviewing Humber professors about best 
practice and promoting their voices on 

http://youtube.com/HumberCTl 

For more information, visit us at:  
http://bit.ly/ctlmediastudio

CTl Creative Studio 
North Campus D225 
Lakeshore Campus  A112

ConTACT:

Eileen de Courcy 
Associate Vice President, 
Teaching & Learning 
416.675.6622 Ext. 4766 
Eileen.Decourcy@humber.ca

Denise gardner
Director, Professional Development 
416.675.6622 Ext. 5743 
Denise.gardner@humber.ca

mark Ihnat 
Director, eLearning 
416.675.6622 Ext. 4752 
mark.Ihnat@humber.ca

Heidi marsh 
Director of Scholarship for Teaching & Learning 
416.675.6622 Ext. 5836 
Heidi.marsh@humber.ca

Darren richards 
Manager, Creative Productions 
416.675.6622 Ext. 5825 
Darren.richards@humber.ca
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elEArnIng
As one half of the CTL, the eLearning Division 
oversees three critical areas:

•	 Instructional Support Studio (The Studio)

•	 Open Learning Centre (OLC)

•	 Online Course Development, Maintenance 
and Management

Supporting all forms of content delivery (web-
facilitated, hybrid delivery and online delivery), 
the eLearning Division and its staff focus on 
andragogy and technical support, helping 
faculty and staff engage in eLearning practices. 
eLearning extends beyond the classroom, as 
faculty, staff and students engage in eLearning 
practices on a daily basis as they pursue 
“personal learning agendas, leisure learning and 
online learning as an adjunct to daily life”1.

For information related to eLearning and 
eLearning workshops please visit:  
http://www.humber.ca/

centreforteachingandlearning/

1 Haythornthwaite and Andrews, 2011

olC PHonE APP
A student-centered app, the Humber OLC Student 
Support app allows students to view Humber’s 
online course offerings, allows them to book our 
study-room, enables easy access to our final exam 
proctor forms, facilitates a live chat session with 
a Student Support Advisor and provides relevant 
information related to our online courses and 
e-learning resources. Current Humber students 
and potential students now can be supported with 
the touch of a button. 

Currently available for Android devices only with 
an iOS app launch planned for Fall 2015.
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Blackboard Support - faculty
Faculty Help Website: http://www.humber.ca/bb91help/instructor.php

Blackboard Twitter Announcements and Support: @HumberBbSupport

Blackboard Tips & Tricks Blog: http://hcblackboardblog.wordpress.com/

Instructional Support Studio:

north Campus - D225J Ext. 4744 lakeshore Campus - D112 Ext. 3288

Faculty support (face-to-face, email, remote access, and telephone support) is available through 
the Instructional Support Studios.

Monday 8:30 a.m. - 4:30 p.m.

Tuesday - Thursday 10:30 a.m. - 6:30 p.m.

Friday 8:30 a.m. - 4:30 p.m.

Saturday and Sunday Basic Blackboard support is available to all faculty 
through email, remote access and telephone.

Blackboard Support - Students 
As faculty, encourage your students to use the following support tools:

Student Help Website: http://www.humber.ca/bb91help/student.php

Blackboard Twitter Announcements and Support: @olCHumber

open learning Centre (olC): http://www.humber.ca/onlinelearning/

north Campus D225 416.645.5049 or 1.877.215.6117 (olC@humber.ca)

Monday to Friday 8:30 a.m. - 8:00 p.m.

Weekends 9:00 a.m. - 5:00 p.m.
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CHECklIST
The following is not an exhaustive list of tasks to be performed, but is meant to assist you in preparing for the upcoming semester.

Pre-teaching Checklist YES NO

Do I have my teaching class schedule?

Do I have my class list(s)?

Do I have my course outline(s)?

Do I have the appropriate resources for my course(s)? (text, articles, etc.)

Do I have any necessary keys?

Do I have my Access Card?

Have I set the dates for the assignments / tests in my course(s)?

Have I verified the presence of my Blackboard courses? 

Have I uploaded my course outline(s)?

Have I uploaded my tentative weekly schedule / critical path?

Do I have the podium code for the electronic classroom(s)? CoDE - 1967 X

Have I visited my classroom(s)?

Do I know the layout of each classroom?

Do I know how to operate the podium and its components?

Do the podium, screens, lights, etc., work?

Do I need flipcharts, markers, chalk, etc.?

Do I have enough chairs for my students?

Do I know where the nearest washrooms are to my classroom(s)?

Do I know where the nearest emergency exits are?

Have I set up my voicemail and email accounts?

Have I checked my mailbox for any room changes and updates?

Have I booked media materials?

Have I prepared my first lesson? Do I have a formal lesson plan?*

Have I planned a break for this class?

Do I need to collect any additional resources?

Do I know where the nearest emergency campus phone is?

*To access information on forming lesson plans and first day strategies, visit: 
http://www.humber.ca/centreforteachingandlearning/

21

Fa
cu

lt
y 

Ha
n

d
bo

o
k 

20
15

-2
01

6

http://www.humber.ca/centreforteachingandlearning/


PArkIng PErmITS
Staff can now obtain parking via the new Services 
tab in MyHumber under Parking ahd Locker.  
http://www.humber.ca/myhumber. 

Permits are required for parking on campus 
between the hours of 6:30 a.m. and 8:00 p.m., 
Monday to Friday. Parking gates are raised at 8:00 
p.m. and go down at midnight. The permit price is 
based on the hours worked in an average week.

Faculty working more than 13 hours weekly 
are considered to be full-time and must pay 
the $293.25 semester fee as approved by the 
Humber Board of Governors.

Faculty working on property 12 hours or less 
qualify for the part-time parking rate.

There are two options at the North Campus for 
permit parking:

option 1: Lot 2, a perimeter lot accessible from 

Driveway A, at a rate of $88.00 per semester.

option 2: Lot 1 and 13, accessible from Driveways 

A & E, at a rate of $176.00 per semester. This option 

is limited based on numbers per academic division.

At Lakeshore, the part-time permit is valid only in 
the West property lot, 3199 Lakeshore Blvd. West 
(off Twenty Third St.), or in the Annex parking lots, 
3120 Lakeshore Blvd. West, at a rate of $88.00 
per semester.

If driving only occasionally, Pay on Exit and Pay ‘n’ 
Display lots are available at North Campus and a 
Pay ‘n’ Display system is active at the Lakeshore 
West property, 3199 Lakeshore Blvd. West.

There is no charge for parking on the weekend.

Parking regulations and Municipal by-laws 
are enforced 24 hours a day. It is the sole 
responsibility of the people parking to ensure that 
their vehicles are parked in accordance with the 
rules, and only in the lot authorized by the permit. 
It is also required that the valid permit be hung 
from the rear view mirror, facing forward, so it is 
clearly visible from the outside.

For additional information, please visit  
http://www.publicsafety.humber.ca
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WElComE To 
mYHumBEr
MyHumber provides students and faculty 
the ability to view and manage information 
about courses, grades, fees and more. 
It offers applicants the ability to track 
application status and manage next steps 
for admission. For employees, MyHumber 
delivers access to forms and information 
needed to perform many operational tasks. 
http://www.humber.ca/myhumber/ 

TImETABlES
Your timetable, including room locations, 
is available online through MyHumber 
- http://www.humber.ca/myhumber/ 
Please check under the Faculty and Advisor 
tab and click on Faculty Week at a Glance.

At the start of the semester, we may have 
to move your class to another classroom. 
When this happens, you will be notified 
via email. Students will also receive an 
email for a room or time change. You can 
also verify this information on MyHumber 
under Faculty Week at a Glance or Active 
Assignments.

ClASS lISTS
Your class lists are available online through 
MyHumber -  
http://www.humber.ca/myhumber/ 

Students can register for classes when 
registration opens until the 5th day of the 
semester. They can drop courses for refund 
within the first 10 days of the semester. 
After the tenth day of classes, you should 
verify your class list. If you have students 
attending your class who are not officially 
registered, please refer them to the 
Program Co-ordinator who can submit a 
SAF to have them registered if warranted.

You may obtain class rosters with pictures 
through MyHumber. 

Best Practice: Students are more 
engaged in their learning if their teacher 
knows their names. Tip: Keep your photo 
roster with you, play name games as an 
icebreaker, and use tent cards.
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VoICEmAIl
Every employee of Humber receives a personal 
mailbox and voice-messaging number. This 
number is a way for students, faculty and staff to 
contact you. This will be supplied to you by your 
school’s Business Office Manager. You will find a 
guide sheet to using the voicemail options in this 
manual under Appendix. 

EmAIl
Your email and voicemail accounts will be set up 
for you by the school’s Business Office Manager, 
prior to the start of the semester. You will be 
provided with this access information at the start 
of the semester.

Every employee of Humber receives a personal 
email address. Microsoft Outlook is the email 
platform in use at the College that you can 
access at any time by visiting https://mymail.
humber.ca/. You will find a guide sheet to using 
the email options in this manual under Appendix. 
Please remember that when communicating 
with your students about academic matters, you 
need to use your Humber email account or your 
Blackboard site. Do not use a personal email 
address when communicating with students.  
http://www.humber.ca/policies/

Faculty can communicate with students in 
Blackboard using the Course Message Tool.

Students report that they prefer faculty using 
just Blackboard as the method for classroom 
electronic communication.
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BlACkBoArD
BlACkBoArD CourSES 

Blackboard is the Learning Management 
System of choice at Humber. Faculty are 
expected to use this software to share 
course information and to communicate 
with students on course specific matters. 
Student assignments can be submitted 
and returned electronically via Blackboard.
For a full demonstration of how Blackboard 
can effectively support and improve the 
classroom experience, refer to The Gold 
Master Blackboard Course. To access the 
Blackboard Gold Master site please contact 
Mark Ihnat mark.Ihnat@humber.ca.

Blackboard courses are automatically 
created, and only faculty assigned as the 
responsible teacher to a section will be 
provided access to the course.

•	 Activate your Blackboard Account 
You use the same account to access 
Blackboard as you do when logging in to 
a computer at the College. This account 
must be activated and the password 
changed before you can use Blackboard.

•	 log in to Blackboard 
Go to the website:  
https://learn.humber.ca  
Enter your username and password and 
click OK. Once you have successfully 
logged in, you may access the courses 
you are teaching by clicking on the link 
which appears in “My Courses”. From that 
point on, you can build your course by 
uploading The Humber Template. If at any 
time you require help using Blackboard, 
click on the HELP link at the bottom left. 

•	 Blackboard eforms 
For Blackboard related requests (adding 
an instructor, merging/crosslisting 
courses) refer to the Information 
Technology Services website https://its.
humber.ca/ > Support Centre > eForms

for help files and Blackboard resources, 
please view the Blackboard 9.1 help 
website http://www.humber.ca/bb91help/

Alternately you can:

•	 Call the Open Learning Centre (OLC) at 
416.675.5049 or 1.877.215.6117

•	 Chat with an OLC Representative through 
the OLC website at:  
http://www.humber.ca/onlinelearning/

north Campus, D225J

Phone: 416.675.6622 Ext. 4744

Email: waterloo.student@humber.ca

lakeshore Campus, D112 (Cottage D)

Phone: 416.675.6622 Ext. 3288

Email: waterloo.studentlakeshore@
humber.ca

Chat support and web-resources 
(eBrochures, video tutorials, etc.) available 
through the eLearning website:  
http://www.humber.ca/
centreforteachingandlearning/
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HoW To ACCESS 
ElECTronIC 
ClASSroomS
Electronic classrooms are fully integrated multi-
media platforms designed to enhance the learning 
experience. All classrooms contain various types 
of multimedia equipment controlled from a 
podium at the front of the room.

Most podiums consist of a keyboard tray, a 
mouse, a flatscreen monitor, and a touch screen 
panel that controls all of the room’s equipment.

If you have questions while in the electronic 
classroom, you can press the help icon located 
on the touch screen panel for instructions on 
how to contact media services. A technician can 
be dispatched immediately by pressing “2” on 
the in-class phone. note: The Podium Password 
is “1967”

If you are teaching in one of Humber’s new 
collaborative classrooms, resources are  
available in person at The CTL and online  
      http://www.youtube.com/HumberCTl  
for CTL Humber Classroom Redesign. 

HumBEr ClASSroom 
rEDESIgn InITIATIVE
Humber is upgrading and updating its classrooms 
to align with 21st-century teaching and learning 
practices. You can learn more about this project 
at http://www.humber.ca/classroomredesign/. 
To practice using one of our collaborative 
classrooms, please come to the CTL and play in 
our mock classroom space, North Campus: D236.
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ID/lEnEl CArDS
All faculty need to have a Humber-issued ID/Lenel 
card. This card will allow you access to a variety of 
services and facilities at Humber.

Requests for classroom keys to specialized 
classrooms should be made to your Program 
Co-ordinator or your Business Manager. If 
deemed necessary, faculty will then be issued 
the appropriate classroom keys. In some cases, 
access to your room is via your ID/Lenel card. 
Once you have obtained your ID/Lenel card, 
access will be activated by the school’s Business 
Office Manager or designate. The faculty member 
bears sole responsibility for the return of each key 
and access card entrusted to him or her. 

ID/Lenel cards should be obtained from IT 
Support Centre at the following campus locations:

north Campus NX210

lakeshore Campus A212

orangeville Campus 0208

Carrier Campus Main Reception

loST/STolEn kEYS

Any person losing a key(s) or ID/Lenel access 
card must notify the Program Co-ordinator or 
Business Manager immediately to ensure against 
a compromise of the system.

rEPlACEmEnT CoSTS

A replacement charge of $20 will be made for each 
key or ID/Lenel access card that is lost/stolen. If a 
key or access card is damaged please return it to 
the school’s Business Office Manager and it can be 
traded for a replacement at no charge.

fACulTY mAIlBoxES
Staff members will be assigned a mailbox in the 
mailroom (at the campus where they are teaching). 
If you are teaching at more than one campus, you 
will have a mailbox at both campuses. Please 
check your mailbox regularly because students will 
drop off assignments with the school secretaries/
receptionists in the assigned drop boxes for 
distribution to your mailbox.
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TExTBookS
If you require textbooks or other resource materials 
for your course, you must let your Program Co-
ordinator know well in advance. In many cases 
these will be provided for you well in advance of 
your class by program staff. It can take over two 
months from the time books are ordered to the 
time they are available in the campus book store. 

At Humber, we also strongly encourage the 
integration and use of digital resources and 
eBooks that are offered via Humber’s Library.

EBookS
The Libraries at Humber offer eBooks for both 
students and faculty. You are able to browse our 
collection and transfer eBooks to your portable 
device or view instantly with our web based 
reader. eBooks support information easier 
and faster with eBook downloads. For further 
information regarding eBooks offered at our 
Humber Libraries please visit the Humber Library 
website at: http://library.humber.ca/programs-list

Want to create your own eBook or eResouce? 
Contact CTL Ext. 5040.
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CourSE ouTlInES
Curriculum design is of the utmost importance 
at Humber and we regularly review our course 
outlines to ensure that they not only reflect 
the Ministry of Training Colleges and University 
standards but also the evolving needs of our 
students’ industry partners. Once outlines have 
been revised by faculty and approved by the 
relevant Associate Dean or Director, they can be 
obtained from the “I” drive. To access the “I” drive, 
complete the following sequence of steps from 
any Humber computer: 

•	 Click on Windows button

•	 Click on Computer

•	 From Computer double click on  
“shares (\\humber.org)(I:)”

•	 Select Departmental

•	 Select Your Department/School (i.e.: Business 
School)

•	 Select 2014 – 2015 Course Outlines

•	 Select the appropriate folder

Humber values sustainability and in our effort to 
help reduce waste we do not normally print course 
outlines. As a result, you will need to upload 
your outline and weekly schedule to your course 
Blackboard sites prior to the start of the semester. 

For additional help in uploading course outlines to 
Blackboard sites please visit:  
http://www.humber.ca/bb91help/instructor.php
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mATErIAlS AnD 
SuPPlIES
Schools try to keep a variety of teaching supplies 
on hand. Supplies are normally kept in supply 
cupboards within each school at our campuses, 
and inventory levels are monitored regularly. If you 
require any teaching supplies that you cannot find 
in the school’s supply cupboard, please see one 
of the program staff and an order will be placed.

Sustainability is one of Humber’s values, and we 
encourage posting information to Blackboard; 
however, a multi-function photocopying machine 
is available in each of the main school office 
areas. In areas where you require a code, this 
will be provided to you by program staff. In some 
schools no code is required. In this case you will 
receive a printing account code from the school’s 
Business Office Manager. Please remember, as 
a professional practice, to cite the source (see 
page 55, copyright). It is an important part of 
respecting intellectual property and modeling 
proper technique to your students. 

Please remember that for any jobs larger than a 
class set (60 pages), please use the Grenville 
Print Centre and allow two business days 
turnaround time. You will need to complete a 
printing order form, available in the school’s main 
office or from the Grenville Print Centre.

You can also submit an online, and electronic 
version of any document that you need printed to 
the Grenville Print Centre. 

grenville Print Centre locations:

Humber College north Campus 
205 Humber College Blvd. 
North Campus H205

Monday – Thursday 9:00am – 6:00pm 
Friday 9:00am – 5:00pm 
416.675.6622 Ext. 4228 
Humber.north@grenville.com

Humber College lakeshore Campus 
3199 Lakeshore Blvd. W. 
Lakeshore Campus H105A 
(next to the Cafeteria)

Monday – Friday 9:00am – 4:00pm 
416.675.6622 Ext. 3584 
Humber.lakeshore@grenville.com
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TESTIng SErVICES
Testing Services are located at the North, 
Lakeshore and Orangeville Campuses as well 
as the Centre for Trades and Technology. The 
Testing Services offer a quiet and controlled 
space for students to write their tests outside of 
the classroom. The centres are monitored by our 
trained invigilation staff. The Testing Services also 
serve students who have disabilities and require 
testing accommodations such as access to a 
computer or assistive technology. 

Our services include:

•	 Make-up or missed tests 

•	 Tests for students with disabilities who require 
accommodation

•	 External Institution Testing

•	 Admission Testing

•	 Placement Testing

Please note that all tests submitted to the Testing 
Services must be submitted with a completed 
referral form, which can be found on our website. 
For up-to-date hours of operations, test referral 
forms, testing services for faculty, and rules and 
regulations please see our website at  
http://www.humber.ca/testcentre/

locations:

Humber north Campus

Learning Resource Commons 
Second Floor (LRC 2141), Ext 4712

Humber lakeshore Campus

Room A235, Ext. 3228

Humber Centre for Trades & Technology

Room CAR145, Ext. 78089

Humber orangeville Campus

Room AL204, Ext. 5902
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mATH AnD WrITIng 
CEnTrES
The School of Liberal Arts & Sciences has established 

facilities at the Humber North, Lakeshore and  

Orangeville campuses to help students who need 

assistance with English and Mathematics.

The Writing Centres, located at Humber’s North, 

Lakeshore and Orangeville campuses, provides 

students with a chance to refine their writing skills and 

to get help with individual assignments. The Centre’s 

friendly tutors welcome the opportunity to work with 

students one-on-one and in small group settings on 

any writing issue, whether these are related to thesis 

development, research, documentation techniques, 

and analytical and technical reading abilities, 

regardless of a student’s program of study. 

Further, reading comprehension skill development 

and language skill development are also offered 

and tailored for English as a Second Language 

(ESL) Learners at the Writing Centre, along with 

Conversational and Pronunciation support.

Students can drop in for help or reserve a tutor 

through our online booking system.  

http://www.humber.ca/liberalarts/las-writing-

centre

The math Centres are drop-in centres offering 
free math help to all Humber students. Students 
do not require appointments in order to get help. 
The Math Centres help with a broad range of math 
problems including basic math, remedial math, 
math of finance, statistics, quantitative methods, 
technical math and calculus. The Math Centres 
can also help with the math component of other 
courses such as nursing and physics. To find out 
more about how the Math Centres can help your 
students, drop by and speak with one of the staff. 
http://www.humber.ca/liberalarts/math-centre

Humber north Campus

Dan Andreae Math & Writing Centre 
Learning Resource Commons, 3rd floor

Humber lakeshore Campus

Writing Centre and Math Centre Room F201
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ACCESSIBlE lEArnIng 
SErVICES 
Humber College is committed to providing an 

inclusive learning environment for students with 

disabilities. To this end, Accessible Learning Services 

partners with students and faculty to ensure that the 

academic environment is accessible. When barriers 

to learning are identified, Accessible Learning 

Services offers a range of confidential services to 

support students with disabilities such as academic 

accommodations, assistive technology training and 

learning supports.

When a student encounters a barrier to access, 

Accessible Learning Services works with the student 

to develop an accommodation plan. This process is 

facilitated as follows: 

1. The student connects with Accessible 

Learning Services to review disability 

related documentation and to develop an 

accommodation plan to minimize the impact of 

the disability or disabilities within the academic 

environment.

2. The student notifies faculty of 

accommodations. This is usually accomplished 

by the student presenting faculty with a copy of 

the accommodation plan as represented by a 

letter or memo prepared by Accessible Learning 

Services. 

3. If the student requires accommodations during 

tests, the student books test dates in advance 

with the Testing Services. Faculty are then 

notified of the booking and asked to provide the 

test directly to the Testing Services.  

Faculty with questions about accommodation 

requests are invited to contact Accessible Learning 

Services. On occasion, faculty may need to explore 

whether or not an accommodation request interferes 

with the essential requirements or learning outcomes 

of a course. Faculty members are encouraged to 

discuss this with Accessible Learning Services.

Contact Information:

North Campus: 2nd Floor LRC 

Lakeshore Campus: Room A120

email:  accessible-learning@humber.ca

phone:  North Campus & Orangeville Campus -   

 (416) 675-5090 

 Lakeshore Campus - (416) 675-6622  

 Ext. 3331
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STuDEnT TESTS AnD 
ASSIgnmEnTS1

Your students are expected to complete all 
tests, assignments and exams within the 
time frames and by the dates indicated 
on the course’s critical path found in 
Blackboard 9.1. Any changes to the 
evaluation scheme contained in the course 
outline must be approved by the Associate 
Dean and then discussed with the class 
and confirmed in writing. 

1 Modified from the Faculty Handbook, 
University of Guelph-Humber; and the 
Humber Policy Manual

grADIng ruBrICS
Rubrics are predefined grading frameworks 
that allow an instructor to efficiently and 
reliably assign grades. Rubrics are shared 
ahead of time with students, so that they 
know the criteria by which their work will 
be graded.

Many program areas will have specific 
grading rubrics that will be shared with you 
at the start of your semester.

The CTL’s website also contains some 
terrific resources that can help you create 
your own rubrics. Please visit: 
http://bit.ly/ctl-rubrics

ATTEnDAnCE2

There is a strong relationship between attendance and 

academic achievement; higher grades are associated 

with regular class attendance. As adult learners, 

college students are responsible for attendance, 

punctuality and facilitating a positive and productive 

learning environment. All students are expected to 

complete all assignments and write all tests/exams 

during the normally scheduled dates and times.

For courses involving computer lab work, practical 

lab classes, significant classroom group activities 

or student/industry guest presentations, 

absenteeism is generally not permitted and may 

result in a failing grade for the course. The specific 

number of absences permitted is clearly stated in the 

individual course outlines. Please refer to your course 

outline to identify attendance requirements. 

Frequent absenteeism may be symptomatic of 

other issues and/or problems. Changes in student 

behaviour and levels of engagement need to be 

investigated. For direction and support, please 

notify your Program Co-ordinator with regard to 

further action.

2 Modified from the Policy Handbook, School of 
Hospitality Recreation & Tourism
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SuBmISSIon of grADES
All students registered in postsecondary, 
postgraduate and degree-level courses will 
receive a midterm grade, which in conjunction 
with discussions with their faculty member, is to 
contribute feedback on academic performance 
and provide students with a realistic idea of their 
performance to date.

At the end of each term, all students registered in 
credit courses will receive a final grade reflective 
of their achievement of course outcomes. 

The Office of the Registrar will establish and 
post to the Academic Calendar (see Appendix) 
midterm and final grade due dates and grade 
release dates, which will indicate when grades 
will be available for students to review.

Faculty are required to submit midterm and final 
grades each term according to the deadlines 
posted in the Academic Calendar.

Faculty are required to submit midterm and 
final grades for all students on their class lists, 
including students who have not attended the 
class or have failed to officially withdraw from 
the course.

Please note that midterm grades are not 
considered part of the official grade point 
average and will not appear on the students’ 
official transcript.

Grades are to be entered via the Faculty tab 
on MyHumber. See Faculty & Staff Learning 
Resources for how to enter grades.
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ClASS CAnCEllATIonS/
ABSEnCES
ClASS CAnCEllATIonS DuE To IllnESS

If you have to miss a class due to illness, you must 
contact the school as soon as possible.

Any class cancellations will be posted by the 
school on the classroom doors. Class cancellation 
notices can also include instructions for your 
students regarding readings, assignments, etc. 
Please post your class cancellation on your 
Blackboard course sites along with instructions 
for your students regarding readings, 
assignments, homework, etc. In some cases, we 
may be able to provide coverage for your class; 
therefore, it is imperative to notify your school/
department as soon as possible.

ClASS CAnCEllATIonS DuE To WEATHEr1

On rare occasions, classes may be cancelled due 
to hazardous weather or emergency situations.  
To this effect, announcements are made on the 
front page of the college website (http://www.
humber.ca), as well as over local radio stations 
and by recorded message to anyone telephoning 
the college at 416.675.6622.

1  Modified from the Faculty Handbook. University 
of Guelph-Humber
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guEST SPEAkErS 
AnD fIElD TrIPS
Humber is committed to providing students 
with an exceptional education experience 
that is both engaging and dynamic. There 
are many ways to create dynamic learning 
environments for your students where 
learning goes beyond the classroom walls 
and allows them to learn by doing.

guEST SPEAkErS

Where and when appropriate, faculty 
may invite industry or guest speakers to 
visit their classes as a way of supporting 
teaching and learning. Before inviting a 
guest speaker, you should speak to your 
Associate Dean or Program Co-ordinator. 
If you are unsure if a guest speaker would 
be right for your course, please discuss this 
with your Program Co-ordinator. 

Connect the speaker’s content to 
lessons, assigments and reflective 
practice. For assistance and ideas on 
how to do this, contact the CTL.

fIElD TrIPS

Before you may proceed with any 
arrangements to take your students on a 
field trip, you must submit a written request 
to your Program Co-ordinator. Such a 
request should be submitted at least 10 
days prior to your trip. This is necessary for 
insurance purposes. Students are protected 
under Humber’s insurance coverage only 
when you have written approval, a Humber 
faculty or staff in attendance and the trip is 
related directly to the curriculum. Contact 
your Program Co-ordinator for details. For 
additional ideas regarding experiential 
learning opportunities visit the CTL at: 
http://www.humber.ca/
centreforteachingandlearning/

To encourage deep learning while on a 
field trip, ask students to either prepare a 
report/presentation or have them blog or 
tweet about the field trip.
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STuDEnT fEEDBACk1

STuDEnT TESTS / ASSIgnmEnTS

Timely and constructive feedback in 
response to students’ work is an integral 
part of the learning process. Students 
should be able to assess their progress in 
a course as early as possible. Instructors’ 
responses should inform, guide and 
encourage students in their learning. 

Utilizing the Grading & Grade Book 
functions on Blackboard is a useful way 
to track student grades and allows you to 
release grades to students letting them 
know where they stand in the course. For 
more information on posting grades to 
Blackboard visit the Help Centre at the 
CTL at http://www.humber.ca/
centreforteachingandlearning/

1 Modified from the Faculty Handbook, 
School of Hospitality, Recreation and 
Tourism.

CollECTIon AnD DISTrIBuTIon of 
STuDEnT Work

The Ontario Freedom of Information and 
Protection of Privacy Act requires that the 
College protect personal information by 
making reasonable security arrangements 
against such risks as unauthorized access, 
collection, use, disclosure or destruction.

Student tests and assignments fall under 
the definition of personal information and 
reasonable security arrangements must be 
taken when receiving and returning tests 
and assignments.

CollECTIng STuDEnTS’ ASSIgnmEnTS

If assignments cannot be handed in during 
class time, they can be dropped off in each 
school’s “Assignment Drop Box” located 
outside of the school’s main office at each 
of the campuses. These will then be date 
stamped and placed in your mailbox. An 
alternative would be to have students 
upload assignments to Blackboard 9.1. You 
can use this technology for uploading and 
tracking student submissions.

rETurnIng STuDEnTS’ TESTS/
ASSIgnmEnTS

It is the professor’s responsibility to return 
graded tests and assignments directly to 
the student. Tests and assignments should 
noT be placed in faculty mailboxes or in 
any other public area for pickup. Students 
are not permitted to handle exams or 
assignments other than their own. 

Students should also have access to their 
marks via Gradebook on your Blackboard 
course site in order for them to gauge their 
progress in your course.

When providing written feedback, do not 
use red pen or place student’s grade/
comments on the cover page. Using red 
pen, in certain cultures, is perceived as 
stressful and may impede learning.2 Tip: 
Use green, purple or any colour except red.

2 Richard L. Dukes, Heather Albanesi, Seeing 
red: Quality of an essay, color of the grading 
pen, and student reactions to the grading 
process, The Social Science Journal, 
Available online 23 October 2012, dx.doi.
org/10.1016/j.soscij.2012.07.005 
Read more at: http://phys.org/news/2013-
01-red-pen-instructors-negative-response.
html#jCp
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STuDEnT fEEDBACk 
QuESTIonnAIrES (SfQS)
At Humber, we value feedback and seek 
opportunities to engage in discussion and 
dialogue about our performance with all of our 
stakeholders. We formally review our programs 
at least once every five years. We also have 
very active and committed Program Advisory 
Committees that provide us with current and 
immediate feedback.

Each semester, all of our classes are involved 
in the Student Feedback Questionnaire (SFQ) 
process during which students are asked to 
provide feedback on their courses and professors. 
We encourage you to familiarize yourself with the 
SFQ (see Appendix) so that you can understand 
ways in which students will be asked to rate both 
your classes and your performance as a professor 
at Humber. SFQs are scheduled to take place 
after midterms. We strongly recommend that 
you avoid administering the SFQ either directly 
before or after a test/quiz has been completed 
or returned. It is also important for you to receive 
feedback from the majority of your students, so 

you are encouraged to announce the SFQ dates 
well in advance and to remind students of the 
importance of the SFQ both for Humber and for 
yourself as a teacher-practitioner.

The SFQ form provides space to ask your students 
up to three specific questions. You will receive a 
list of suggested questions, but you are free to 
create your own. When adding questions to the 
SFQ, please be sure that the question is framed so 
that the most desirable answer is in the “Strongly 
Agree” column.

You may want to solicit feedback from your 
students sooner in the semester and at more 
regular intervals. This can be easily accomplished 
in many different ways. Visit the CTL website to 
access a variety of helpful tools and resources 
that you can use throughout the semester.  
http://bit.ly/ctl-feedback

Use a variety of Classroom Assessment 
Techniques (CATs) to assess student learning 
and to better understand your effectiveness as a 
teacher. For more info go to: http://humber.ca/
centreforteachingandlearning/ 

http://youtube.com/HumberCTl
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kEY PErformAnCE 
InDICATorS (kPIs)
The Key Performance Indicators (KPIs) survey 
is a method of measuring how well colleges 
in the province of Ontario meet the needs of 
students and the marketplace and is used as a 
basis for performance funding. KPIs also ensure 
that programs remain strong, responsive and 
needs-focused. The KPI survey is administered 
annually during the first week of February, by an 
independent body on behalf of the Ministry of 
Training, Colleges and Universities in conjunction 
with Colleges Ontario.

The five key performance indicators listed below 
are used to measure the performance of Colleges 
in achieving Ministry stated outcomes and 
objectives.

•	 Graduate Employment

•	 Graduate Satisfaction

•	 Employer Satisfaction

•	 Student Satisfaction

•	 Graduation Rate

Please familiarize yourself with the questionnaire 
(see Appendix) so that you may be able to 
understand ways in which students may be asked 
to rate their experience at Humber and in your 
courses.

For more infomation on Ministry KPIs, go to: 
http://www.humber.ca/strategicplanning/kpi-qa
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HElP
All incoming students are also asked to 
complete the HELP survey.

What is HElP?

HELP is the Humber Engagement and 
Learning Profile survey for incoming 
students. 

Developed by a cross-institutional advisory 
group, HELP is a cutting-edge incoming 
student survey. 

WHo IS HElP for?

HELP asks incoming first-semester students 
in certificate, diploma and degree programs 
to tell us about their preparation for college, 
their educational and career goals, early 
opinions about their program and Humber 
generally, and to identify particular student 
support services they may use. 

WHEn DoES IT HAPPEn?

The HELP survey is open to incoming 
students during the third and fourth weeks 
of class each semester. 

The survey is administered online and takes 
approximately 10 minutes to complete. 

WHY IS HElP ImPorTAnT? 

Students share how we can help them 
be successful at Humber, and receive 
individualized emails and timely information 
about Humber’s services based on areas of 
assistance they identified as beneficial. 

Humber Institutional Research creates 
reports based on student responses to key 
questions and distributes these to student 
service areas as well as academic faculty/
staff.

Aggregate data at the program, school 
and college levels will inform institutional 
retention strategies that will help more 
students be successful in their program. 

WHErE CAn You gET HElP Info?

To ask questions or learn more about the 
survey or reports please contact Humber 
Institutional Research.

Corrine Johnston 
Director 
Strategic Planning and Institutional 
Analysis (SPIA) 
416.675.6622 Ext. 4630  
corrine.johnston@humber.ca

Pat Van Horne 

Manager  
Strategic Planning and Institutional 

Analysis (SPIA) 
416.675.6622 Ext. 4943  
patricia.vanhorne@humber.ca

Improving student success is an 
institutional priority, and benefits all of us!
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TESTS, ASSIgnmEnTS 
AnD ExAmS
fInAl ExAmS AnD TESTS 

At Humber we strive for academic excellence and 
introduce processes that emphasize academic 
integrity in all that we do. Tests and exams are 
opportunities to allow students to demonstrate 
academic excellence and integrity.

TEST AnD ExAm ProToCol AnD ConDuCT1

Consider using some or all of the following 
suggestions when conducting an examination:

•	 Students may not enter the test/exam room 
until the faculty member is present and has 
directed the students to enter.

•	 Seats may be pre-assigned by the faculty 
member.

•	 Students may be asked to provide a valid 
student ID card, with photo, to be eligible to 
write the examination. No other identification 
will be accepted.

1 Modified from the Policy Handbook, School of 
Hospitality, Recreation & Tourism

•	 Students are to bring only what is necessary to 
the test/examination room. All personal effects 
are to be stored in the students’ lockers, or in 
an unsupervised, designated area in the exam 
room, as determined by the faculty member.

•	 All cell phones and other electronic devices must 
be turned off and placed with other personal 
belongings/bags in the designated area.

•	 No outerwear such as hats, gloves, overcoats, 
jackets, vests, etc. are permitted to be worn. 
Religious head coverings are exempted.

•	 Students must be punctual for all tests and 
examinations. Students must stay in the 
examination room for the first 30 minutes. 
After 30 minutes, students may exit quietly by 
submitting their exam/test and all paper used 
during the exam to the faculty member.

•	 Once a student has left the examination room, 
there will be no re-admittance. Students are 
directed to use the washroom prior to entering 
the exam.

•	 No student is permitted to leave the examination 
room in the last 15 minutes of the exam.
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•	 Students are to follow the instructions of 
the faculty member for collection of exams 
and dismissal procedure at the end of the 
examination.

•	 Faculty members have the authority to direct 
students to move to another seat during the 
test/exam.

Review current research on Why Students Cheat, 
Prevention, and Academic Intergity Policy on the 
CTL website.  

http://bit.ly/CTl-academic-integrity

STuDEnTS mISSIng ExAmS1

All tests and assigned course work, as described 
in the course outline, will have their due date 
announced in class prior to the actual date. 
Advising students to synchronize their Outlook 
and/or Google calendars via Blackboard would be 
ideal in helping students track important dates. 
However, it is the students’ responsibility to be 
aware of the dates of tests and assigned course 
work. Students who are late for tests will not be 

1  Modified from the Policy Manual, School of 
Hospitality, Recreation & Tourism

given extra time, unless there are extenuating 
circumstances. If a student misses an 
evaluation, the student must contact the course 
instructor within 24 hours of the evaluation to 
discuss an extension or seek permission to 
write a makeup test/assignment. Permission 
to make up the missed evaluation is granted 
by the faculty member and you are encouraged 
to discuss such requests with the Program 
Co-ordinator to ensure we are consistent in our 
decision making. Please note that information 
regarding make up tests and/or evaluations 
must be included in our course outlines. Please 
review the outline carefully to ensure that you are 
following established program policies.
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SuBmITTIng fInAl 
grADES
mIDTErm AnD fInAl grADES

You are required to submit both midterm and 
final grades for each of your students, in each 
of your classes. At Humber, we submit grades 
electronically using MyHumber. Information will 
be distributed to faculty several weeks in advance 
of each deadline illustrating the MyHumber grade 
submission process. Faculty are encouraged to 
submit their grades as early as possible. At the 
end of each semester, you will also be required 
to submit a copy of your final grades and a grade 
breakdown to your school. These copies are used 
to help respond to student and program enquiries 
as well as requests from the Office of the 
Registrar when grades are missing or incomplete. 

Please refer to the Academic Calendar dates in 
the Appendix.

CHAngIng A STuDEnT’S 
grADE
Under extenuating circumstances, faculty will have 
six weeks, following the end of the semester, to 
reassess a student’s final grade and submit any 
changes to the Office of the Registrar for input. 
Changes beyond the six weeks will be permitted 
only if authorized by the Dean and/or designate.
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rETAInIng STuDEnT 
Work AnD grADES
Each academic school is required to retain 
unreturned graded tests, assignments and final 
exams for 12 months after the end of term, or 12 
months after the date of the last use.

Please provide a copy of these items along with a 
copy of your final grades to your Program Co-
ordinator or designate as indicated by your school’s 
Business Office Manager or Associate Dean.

SAmPlES of STuDEnT 
Work for DEgrEE 
STuDY
We are also required to retain samples of degree 
student work in the terminal stage of the program 
and for breadth courses. During the registration 
process, degree students indicate their agreement 
to the collection of sample work. Files may be 
stored electronically. Video or photo images of 
completed work for design/studio projects are 
appropriate. Samples must be sorted and reflect 
student work that is exemplary, average and 
minimally acceptable. There should be sufficient 
numbers of assignments for external reviews to 
randomly select samples from each category. 
No personal information (e.g. student name, ID 
number etc.) should appear on the samples.
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ACADEmIC rEgulATIonS
Our Academic Regulations contain important 
information and highlight important processes. 
You are encouraged to make yourself familiar with 
Humber’s Academic Regulations. Please note that 
our Academic Regulations can vary depending on 
which program you are teaching at Humber. To 
view the Academic Regulations please select the 
appropriate link below:

•	 2015–2016 Admission Requirements & 
Academic Regulations for Degree, Diploma and 
Certificate Studies

•	 2015–2016 Admission Requirements & 
University Regulations for the Bachelor of 
Nursing Degree Program 

•	 http://www.humber.ca/admissions/
academic-regulations

Please note that Academic Regulations 
apply to all credit courses and programs at 
Humber. Academic schools may have specific 
supplementary procedures that derive from our 
Academic Regulations and are communicated to 
students when they first begin their studies. These 

supplementary procedures are often included in 
school-specific, or program-specific handbooks 
available from the Program Co-ordinator and/or 
the Associate Deans.

PolICIES AnD ProCEDurES - ACADEmIC 

In addition to our Academic Regulations, there 
are many different policies and procedures that 
govern Humber’s day-to-day operations. For 
example, there are several policies in place at 
Humber that focus on teaching and learning:

Academic Freedom Policy

Academic Honesty of Faculty and Staff Policy and 
Procedure

Copyright Policy

Fair Dealing Policy

Student Feedback Questionnaire Policy 

All of our policies are available on our website at: 
http://www.humber.ca/policies/
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AuDITIng A CourSE

Where applicable, a student may apply to audit a 
course. A student must obtain written permission 
to audit a course from the appropriate Associate 
Dean and present the authorization to the 
Customer Service and Registration Centre at the 
time of registration. Students who are auditing 
courses will not be evaluated nor will credits be 
earned. The regular fee applies.

lAST DAY To DroP A CourSE WITHouT 
ACADEmIC PEnAlTY

To drop a course and have it removed from 
an official transcript, students must apply to 
drop the course through the Admissions and 
Registration Centre. (It is not sufficient for 
students to just tell their instructor.) The last day 
to withdraw from a course without academic 
penalty is two-thirds of the way through the 
course. Students are encouraged to check the 
academic calendar for the exact date (See 
Appendix). After that, the course will remain 
on the student record with the grade earned 
showing as a final grade.

Grades will be reported in percentages, unless 
otherwise specified in the course outlines. A 
pass in each course will be fifty (50%) unless 
otherwise indicated. 

For further information, visit http://www.humber.
ca/admissions/academic-regulations
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ACADEmIC 
ComPlAInTS/APPEAlS
Student Appeal Procedure

Students should be aware they have the right to 
appeal a course, grade or a program standing.

When a student disagrees with a grade received 
or any decision resulting from the Academic 
Regulations, the following informal procedure 
should be followed before making a formal appeal:

•	 The student should first discuss the matter with 
you, the instructor, in an attempt to resolve the 
disagreement

•	 If the matter remains unresolved with the 
instructor, the student should discuss the 
matter with the Program Co-ordinator

•	 If the student is not satisfied at this point, the 
student meets with the Associate Dean to try to 
resolve the situation at the school level

•	 If the student is still not satisfied at this point, 
the student meets with the Dean to try to 
resolve the situation at the school level

If the student is still not satisfied, a formal appeal 
in writing may be initiated to the Registrar. Such 
documentation must be completed within 10 
days from the end of the course. Full details can 
be viewed online at http://www.humber.ca/
admissions/academic-regulations

The outcome of a formal appeal is officially 
communicated to the students and all parties 
involved. 
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ProgrESSIon/
PromoTIon mEETIngS
At the end of term, many of our programs have 
progression or promotion meetings to review our 
students’ academic progress. Your participation in 
these meetings is crucial as decisions regarding 
academic standing can only be made when the 
appropriate faculty come together to review a 
student’s academic record. 

Information regarding the date and time of 
progression/promotion meetings will be provided 
to you by the Program Co-ordinator.
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STuDEnT SuCCESS AnD 
EngAgEmEnT (SSE)
Student Success and Engagement (SSE) 
comprises a range of services that share the 
common goal of supporting students’ personal 
and academic success. The various services are 
designed to provide support and resources to 
students, faculty and staff, taking the approach 
that each student’s education is enhanced by the 
range of opportunities, and interactions available 
both inside and outside of the classroom. 
Services include:

•	 Aboriginal Resource Centre

•	 Athletics and Recreation

•	 Career Centre

•	 Peer Tutoring and Mentoring

•	 Residence Life 

•	 Service Learning

•	 Student Code of Conduct (Non-academic 
behaviour)

•	 Student Life Programs (including Leadership 
Development and Orientation activities)

•	 Student Wellness and Accessibility Centre

•	 Testing Services

For more information related to any of these 
services, please contact the Office of the Dean 
of Students at Ext. 4872, or visit Humber’s 
website for specific office locations and contact 
information.

http://wegotyou.humber.ca
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HumBEr lIBrArIES
Come to the circulation desk to activate your 
library account to access print, multimedia 
and online collections, which include books, 
journals, magazines, newspapers, videos and 
encyclopedias. Distance education faculty can 
apply for an account online at  
http://library.humber.ca/get-account

Humber north library, lrC Building 4th floor

Circulation: 416.675.5079

reference: 416.675.6622 Ext. 4421

Hours of operation: 

Monday to 
Thursday

7:30 a.m. – 10:00 p.m.

Friday 7:30 a.m. – 6:00 p.m.

Saturday 8:30 a.m. – 5:00 p.m.

Sunday 12:00 p.m. – 5:00 p.m.

Humber lakeshore library, Building B

Circulation: 416.675.6622 Ext. 3247

reference: 416.675.6622 Ext. 3351

Hours of operation: 

Monday to 
Thursday

7:30 a.m. – 10:00 p.m.

Friday 7:30 a.m. – 6:00 p.m.

Saturday 8:30 a.m. – 5:00 p.m.

Sunday 12:00 p.m. – 5:00 p.m.
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CollECTIonS AnD InSTruCTIon

Contact your faculty liaison librarian if you need 
materials to support your course. Your librarian will 
also work with you to enhance student research 
skills through classroom visits, assignment 
development, or online tutorials.  
http://library.humber.ca/liaison-librarians

 
InTErlIBrArY loAn

You can borrow material from other academic 
institutions. Place a request using the InterLibrary 
Loan at http://library.humber.ca/interlibrary-loan

 
CoPYrIgHT

Humber College is required to comply with 
Canadian Copyright Law, institutional licensing 
agreements and the Universal and Berne 
International copyright conventions to which 
Canada is a signatory. This means that the 
reproduction, use and dissemination of copyright 
protected materials, regardless of format, are 
subject to certain limits and restrictions.

It is the responsibility of Humber faculty to 
be aware of the restrictions and to copy 
and distribute materials in accordance with 
institutional directives.

For details on allowable limits, go to:  
http://library.humber.ca/copyright 

If you have any questions regarding the 
appropriate use of print and online materials, 
please contact library copyright staff at 
copyright@humber.ca.

 
unIVErSITY of guElPH-HumBEr lIBrArY 
SErVICES

Go to http://www.guelphhumber.ca/library  
for details.
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InTErnATIonAl STuDEnT 
SErVICES 
Humber provides specialized services for 
international students. The International Centre 
assists students with questions regarding study 
and work permits, transition, housing, health 
insurance and employment. In addition to acting 
as a resource to students, the International Centre 
provides various opportunities for students to 
learn more about Canada and meet new friends. 
The International Centre also houses many 
resources on work/study abroad, multiculturalism 
and other international issues. Visit http://
International.humber.ca for more information. 

north Campus: LRC 2185 Front desk Ext. 5067

lakeshore Campus: H100A Front desk Ext. 3178

Email: international@humber.ca

Contact:

Diane Simpson 
Dean, International Centre 
416.675.6622 Ext. 5630 
diane.simpson@humber.ca

kim Smith 
Associate Director International Admissions  
and Student Services 
International Centre 
416.675.6622 Ext. 5968 
kim.smith@humber.ca
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rESEArCH offICE
Applied research is an important part of 
Humber’s strategic vision. Research activities 
enable faculty to provide meaningful 
learning activities both inside and outside 
the classroom. Students benefit by applying 
classroom learning to industry challenges; 
these experiences make Humber students 
market-ready on graduation.

Students may be involved in research

•	 as part of the curriculum, including class 
projects and capstone projects individually 
or in teams

•	 as work-study students or as research 
assistants to faculty members

•	 as entrepreneurs in the HumberLaunch 
incubator

The research Department supports faculty 
researchers by:

•	 fostering relationships and facilitating 
research projects with industry, especially 
with Small and Medium Enterprises (SME) 

•	 identifying potential funding opportunities

•	 offering internal funding for staff initiated 
research projects (SIRF) and Developing 
Activities and Idea for Research (DAIR)

•	 providing mentorship in developing 
research projects including refining the 
research question 

•	 providing workshops and other learning 
activities for faculty interested in 
developing a research proposal

•	 matching faculty/staff for collaborative 
research opportunities 

•	 providing assistance in developing grant 
applications

•	 providing assistance in developing 
applications for ethical approval (either 
individual projects or course designation)

•	 providing project management and other 
work-study student assistance for research 
projects

To Apply for Research Ethics Approval – 
http://www.humber.ca/research/faculty

To Apply for SIRF Funding – http://www.
humber.ca/research/node/161

To Apply for DAIR funding – http://www.
humber.ca/research/faculty/opportunities

Please contact us with queries related to 
Humber Research. Our offices are located at 
the North campus in LX104A.

Patricia morgan, PhD 

Dean, Research 

416.675.6622 Ext. 4525 

patricia.morgan@humber.ca

Amanda Brown 
Research Co-ordinator 
416.675.6622 Ext. 5722 
amanda.brown@humber.ca

laura keating, mSc, CCrP 
Research Facilitator 
416.675.6622 Ext. 5592 
laura.keating@humber.ca

krista Holmes  
Research Co-ordinator 
416.675.6622 Ext. 5721 
krista.holmes@humber.ca
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HumBEr ProgrAm 
PlAnnIng, 
DEVEloPmEnT & 
rEnEWAl

WHo WE ArE 

The Program Planning, Development and Renewal 
department reports to the Vice President, 
Academic.

Program Planning & Development

The Program Planning & Development Office 
is responsible for assisting with the design 
of new programs and the preparation of 
program applications including apprenticeship, 
postsecondary certificates, diplomas, advanced 
diplomas and graduate certificates in addition 
to Ministerial Consent and/or Consent renewal 
applications for Humber’s degree programs.

Program renewal

The Program Renewal Office is responsible for 
the formal review of Humber’s postsecondary 
programs. The intent of the process is to critically 
examine all aspects of the curriculum and the 
delivery of that curriculum associated with a 
program. 

Program Planning & Development

The department’s activities include:

•	 conducting market research to determine the 
need for new programs;

•	 working with the Vice-President Academic 
to determine priorities for new programs, 
enrolment planning, and special college 
projects;

•	 working with curriculum experts in developing 
new programs;

•	 working with academic school administrators 
and faculty in planning and designing new 
programs;

•	 conducting curriculum reviews;

58

Fa
cu

lt
y 

Ha
n

d
bo

o
k 

20
15

-2
01

6



•	 shepherding new programs and consent 
renewals through the internal and 
external approval processes;

•	 preparing the new program applications 
for Ministry approval;

•	 managing curriculum changes;

•	 planning and managing external site 
visits; and

•	 working on special projects.

Applications are prepared in conformity 
with Humber and Ministry guidelines and, 
in the case of baccalaureate degrees, the 
requirements for consent and consent 
renewal set by the Postsecondary 
Education Quality Assessment Board. 

Program renewal

The process followed for program review at 
Humber is aligned with the requirements 
set by the Ontario College Quality 
Assurance Service for non-degree programs 
and the Postsecondary Education Quality 
Assessment Board for degree programs.

Three Stages to a Program review

•	 First, the program administrators and 
faculty members complete a self-
study which includes an analysis of the 
program outcomes, course outcomes, 
content and delivery, student experience, 
resources, external stakeholder 
relationships, program retention, 
graduation rates and employment 
outlook.  The self-study also includes 
student feedback obtained through focus 
groups. 

•	 Next, the program goes through an 
external assessment;  two assessors, 

usually an academic and an industry 
expert in the case of non-degrees, review 
the internal assessment documents and 
then conduct a site visit where they meet 
with  program staff, current students, 
graduate students, and advisory 
committee members. 

•	 Lastly, based on the report submitted by 
the external assessors, an action plan 
is drawn up that identifies the changes 
or improvements a program should 
implement in order to strengthen the 
program.  Action plans are reviewed by 
the Vice President Academic who also 
ensures that the plans are implemented.

All programs at Humber are formally 
reviewed at least once every five years.

http://www.humber.ca/program-
development/
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HumAn rESourCES 
(Hr) SErVICES
Humber employees have access to a variety of 
benefits. Updated information about wages and 
benefits are available to Humber employees 
on the Human Resource Services website, as 
are all postings for permanent and contract 
opportunities. Please visit http://hrs.humber.ca/ 
to learn more.

ComPEnSATIon & BEnEfITS

Faculty and staff are paid bi-weekly via direct 
deposit. Please speak to your Associate Dean 
or school’s Business Office Manager about your 
wages and/or benefits. Employees can also 
contact Sherry fast Ext. 5089 with questions 
about wages, or Joanne Baker Ext. 4023 with 
questions about benefits. 

TYPES of BEnEfIT CoVErAgE:

•	 Dental

•	 External Health

•	 Life Insurance

•	 Sick Days/Short Term Disability/Long Term 
Disability

•	 Pension

For more information, please visit:  
http://hrs.humber.ca/
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Contact:

lori A. Diduch 
Vice-President, Human Resources 
416.675.6622 Ext. 4520  
loriA.Diduch@humber.ca

Christy lihou 
Manager, Academic Staff Relations 
416.675.6622 Ext. 4225  
Christy.lihou@humber.ca

Joanne Baker 
Benefit Consultant 
416.675.6622 Ext. 4023  
Joanne.Baker@humber.ca

Eloise Etcubanez 
HR Consultant 
416.675.6622 Ext. 4021  
Eloise.Etcubanez@humber.ca

Christa Hinds 
Sr. HR Consultant 
416.675.6622 Ext. 3325  
Christa.Hinds@humber.ca

Sherry fast 
Compensation Analyst 
416.675.6622 Ext. 5089  
Sherry.fast@humber.ca

noreen gomes 
HR Office Manager 
416.675.6622 Ext. 4896 
noreen.gomes@humber.ca
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HumAn rIgHTS, EQuITY 
& DIVErSITY
Human Rights, Equity & Diversity has been a 
formal program in Humber’s Human Resources 
Services since the 1990s and its mandate is to 
assist Humber in increasing equity and inclusion 
throughout the College. Programs and initiatives 
of the office focus on the prevention of human 
rights violations through education, training and 
early complaint resolution. 

The office provides the following services to the 
Humber community:

•	 Prevention Education: Education provided 
through workshops, library exhibits, fact sheets 
and lecture series;

•	 Resource and Support: Group and one-to-one 
training support and resources on Human 
Rights, Equity & Diversity issues;

•	 Human Rights Complaints Resolution: Early 
intervention into human rights related concerns, 
provision of information, investigation, 
conciliation and referrals where deemed 
necessary;

•	 Referrals: Referral to internal departments (for 
example, Counseling or Accessible Learning 
Services) and external organizations;

•	 Community Collaboration: Works alongside local 
and national communities to enhance Humber’s 
visibility, attract prospective students and staff 
from diverse communities and to maintain a 
competitive advantage within the college and 
university arenas;

•	 Human Rights, Equity & Diversity Website: 
Provides educational resources that may 
strengthen Humber’s online communities’ 
understanding of human rights, diversity and 
equity related issues;

•	 Equitable Employment: Works towards 
increasing representation of Employment Equity 
for designated groups as well as other groups 
within the college community; and

•	 Accessibility for Ontarians with Disability Act 
(AODA): Leads and co-ordinates Humber’s 
compliance with the AODA. 
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Centre for Human rights, Equity & Diversity in 
Human resources Services

Human Resources Services, Learning Resource 
Commons, 5th Floor, Humber College, 205 
Humber College Blvd. Toronto, Ontario M9W 5L7

nancy Simms 
Director, Centre for Human Rights,  
Equity & Diversity  
416.675.6622 Ext. 4425  
nancy.simms@humber.ca

Candice Warner-Barrow 
Co-ordinator, Human Rights, Equity & Diversity 
416.675.6622 Ext. 4808 
candice.warner-barrow@humber.ca
 
Hours: Monday-Friday: 9:00 a.m. – 5:00 p.m.  
Evening appointments are available with  
advanced notice. 
humanrights@humber.ca

http://hrs.humber.ca/human-rights-equity-
diversity.html

ACCESSIBIlITY for 
onTArIAnS WITH 
DISABIlITIES ACT (AoDA)
The goal of the Accessibility for Ontarians with 
Disabilities Act (2005) is to “develop, implement 
and enforce accessibility standards” to ensure 
accessibility for all Ontarians.

As an employee at Humber, you are required to 
complete AODA Training. The online trainings are 
available though The Centre for Human Rights, 
Equity & Diversity in Humban Resources. 

For more information on the AODA and to access 
the online training modules, please visit:  
http://hrs.humber.ca/human-rights-equity-
diversity.html

Contact:

Jessica Bowen 
Manager, Human Rights, Equity & Diversity 
416.675.6622 Ext. 5685   
jessica.bowen@humber.ca

63

Fa
cu

lt
y 

Ha
n

d
bo

o
k 

20
15

-2
01

6

http://hrs.humber.ca/human-rights-equity-diversity.html
http://hrs.humber.ca/human-rights-equity-diversity.html
http://hrs.humber.ca/human-rights-equity-diversity.html
http://hrs.humber.ca/human-rights-equity-diversity.html


DEPArTmEnT of PuBlIC 
SAfETY
The Department of Public Safety is committed 
to ensuring the safety and security of Humber 
College’s students, staff and faculty. A 
comprehensive breadth of services coupled with 
close community relations with Toronto Police 
Service, Toronto Fire Service and Crime Stoppers 
allow Public Safety to maintain a safe and secure 
learning and work environment. 

Your familiarity with the following emergency 
procedures and Public Safety services will 
help ensure that you, your students and your 
colleagues are prepared to respond in the event of 
an emergency.

EmErgEnCY 
PrEPArEDnESS
In an emergency situation, contact Security by 
calling 416.675.6622 Ext. 4000 from an on-
campus phone, your cellphone or an emergency 
phone located around campus. Emergency phones 
are a free direct line to Security. You will be 
required to provide the following information:

•	 Your name

•	 Your location

•	 Location of the incident

•	 Nature of the emergency

For non-emergency situations, such as Campus 
Walk, room openings or other inquiries Security 
can be contacted at 416.675.6622 Ext. 8500. 
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fIrE ProCEDurES
DuTIES of InSTruCTorS DurIng 
EmErgEnCIES

When you are in a classroom, lab and other 
assembly or work areas, and the fire alarm bells 
sound, proceed as follows:

•	 STOP the class and any learning activities

uPon HEArIng A fIrE AlArm

If Intermittent Signal (beeping sound every two 
(2) seconds)

•	 Stand by and prepare to leave the building

•	 DO NOT use the elevators

If Continuous Signal (three (3) fast beeps 
followed by a short pause)

•	 Close doors behind you

•	 Leave building by the nearest exit

•	 DO NOT use the elevators

Important note: If you encounter smoke, use an 
alternate exit. If smoke is heavy in the corridor, 

it may be safer to stay in your area. Close doors, 
block openings, and stay low to the floor at a 
window if available.

uPon DISCoVErY of fIrE

•	 LEAVE fire area immediately

•	 CLOSE doors behind you

•	 SOUND the fire alarm, pull manual alarm station

•	 LEAVE the building by the nearest exit

•	 DO NOT use the elevators

Provide assistance to any persons with 
accessibility needs you encounter while 
evacuating. If you are unable to do so, tell them to 
stay where they are and that you are getting them 
help and immediately inform Security where this 
person(s) is located.
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EVACuATIon
1. EXIT the building immediately if you are able 

to do so safely

2. NOTIFY anyone you encounter to exit the 
building immediately 

3. CALL 911. Provide as much information as 
possible

If you are unable to exit the building safely, 
immediately go to the nearest area where you feel 
safe. Follow the lockdown instructions.

loCkDoWn ProCEDurES

4. LISTEN for instructions via the public address 
system 

5. GATHER others from open areas

6. CLOSE and lock the door

7. COVER windows if possible

8. IDENTIFY the location of injured persons by 
placing signs in exterior windows

9. GET LOW and lie on the floor or crouch 
behind desks

10. SILENCE cell phones or devices that generate 
noise

11. DO NOT answer the door

12. CALL 911 if you have specific information 
about the threat 

13. DO NOT EVACUATE until contacted by the 
Toronto Police Service or the Department of 
Public Safety 

For more information on lockdown procedures 
and the lockdown video visit: http://humber.ca/
publicsafety/content/lockdown-exercises
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CAmPuS SECurITY
The security team is available 24 hours a day and 
employs a wide array of trained professionals to 
assist Humber students, staff, faculty and visitors. 

Security Reception is located at the front of the 
NX Building at the North Campus and in M106 at 
the Lakeshore Campus. 

Campus Security is available 24 hours, 7 
days a week. The following security programs 
and services have been implemented to keep 
Humber’s campus safe and secure: 

•	 Campus patrols by uniformed Security guards

•	 Posted Security Notices

•	 Campus Walk Program

•	 Work Alone Service

•	 Off Hook Service

•	 Humber Emergency Auto Response Team 
(H.E.A.R.T)

•	 Interior and exterior Emergency Phone system

For more information on Public Safety’s programs 
and services or to view the locations of the 

campus Emergency Phones, visit the Humber 
College Department of Public Safety website at: 
http://humber.ca/publicsafety/

HumBEr guArDIAn APP
The Department of Public Safety has released 
the Humber Guardian app for Apple, Android and 
Blackberry Smartphones! 
http://www.humber.ca/publicsafety/guardian

The Guardian is designed for Humber students, 
staff and faculty and provides quick access 
to campus safety and security resources, 
emergency contact information, safety services 
and a safety toolbox.
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Work AlonE
The Work Alone program is for staff and faculty 
who work past standard business hours. This 
service allows you to register with security for 
periodic check-ins to ensure your safety when 
working late.

You may request this service by:

•	 Checking in at Security Reception 

•	 Notifying a security guard

•	 Calling extension 8500 or 416.675.8500

H.E.A.r.T. ProgrAm
The Humber Emergency Auto Response Team 
(H.E.A.R.T) is a program designed to help anyone 
who is experiencing vehicle problems while on-
campus. 

To access this service, call Parking Services at 
416.675.6622 Ext. 8500 or through any emergency 
telephone. Parking Services will dispatch someone 
to help you get on your way safely.

If Parking Services is unable to get you on your 
way, they will provide access to a telephone and 
the appropriate contact information to arrange 
emergency assistance.
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CAmPuS WAlk 
ProgrAm
The Campus Walk program provides a walking 
partner for students, employees and visitors who 
wish to be accompanied to their vehicle on the 
property, to the campus residence or anywhere 
within the perimeter of the campus property. 

To request this service:

1. Contact Public Safety at: 
a. north Campus: Security Reception near 
the Library entrance or phone 416.675.6622 
Ext. 8500 
b. lakeshore Campus: Security Reception 
in M106 or phone 416.675.6622 Ext. 8500

2. Campus Walk will then meet the person 
requesting the walk at their chosen meeting 
place

3. The Campus Walk team will present 
identification

4. The person(s) requesting the walk will be 
accompanied to their requested location

EmErgEnCY ConTACT 
InformATIon
Humber North and Lakeshore 
Campuses

Ext. 
4000

Humber Orangeville 911

Humber Transportation Training Centre 911

Humber Sailing & Powerboating Centre 911

Police/Fire/Ambulance 911

For safety information and security updates, visit 
the Public Safety website at:  
http://humber.ca/publicsafety/

non-EmErgEnCY 
numBErS
Public Safety (North and Lakeshore) 
416.675.8500 or Ext. 8500

For more information about our programs, services 
and for security updates, visit the Public Safety 
website at: 
http://humber.ca/publicsafety/
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DInE on CAmPuS
The Humber room is a full service upscale-
casual restaurant, located at the Humber’s 
North Campus. World class lunches and dinners 
are prepared by students in culinary programs at 
Humber who are studying to become chefs. The 
service in the restaurant is provided by students 
studying in a hospitality program at Humber.

fall Semester 2015:

lunch:

Monday to Friday 11:45 a.m. – 1:15 p.m

Dinner:

Monday to Thursday 6:15 p.m. – 7:45 p.m

Spring Semester 
2016:

Open May until June

lunch only:

Tuesday to Friday 11:45 a.m. – 1:15 p.m.

other Dining options

Good food is an integral part of the campus life 
experience. Humber’s diverse dining program 
makes it easy for students, faculty and staff 
to eat well-balanced meals at any of our many 
convenient campus locations. Humber has a 
passion for providing quality food and services 
with a focus on freshness, satisfaction and value. 
This is reflected in the freshly prepared menus 
and the hallmark brands we offer such as  
Big Pita, Booster Juice, gH Café, Pizza Pizza, 
Second Cup, Starbucks, Subway, Teriyaki 
Experience, Tim Hortons, Yogurty’s and many 
more.

Offering Halal, vegan or vegetarian options, 
Humber is committed to providing food that meets 
the needs of the Humber community.

For additional information and hours of operation, 
please visit http://dineoncampus.ca/humber
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ATHlETICS
ATHlETICS CEnTrE

Most of the activities and facilities of the Athletic 
Centre are available to you free of charge. They 
include weight room, fitness classes, fitness 
testing, cardio room, three gymnasiums, lockers 
and showers.

Access to all facilities will be given with your photo 
ID card, obtained from your IT/Media Services 
desk at the following locations:

north Campus: NX210

lakeshore Campus: A212

orangeville Campus: 0208

Carrier Campus: Main Reception

EnTrAnCE

A valid identification card must be presented to 
gain entrance to the Humber Athletic Centre.

DrESS

Proper gym attire and non-marking running shoes 
must be worn at all times while using the athletic 
centre.

ConDuCT

A strict code of conduct is in place. Those not 
adhering to the facility rules will be asked to leave 
or not be admitted. Continuous abuse of the 
facility and/or staff may result in the cancellation 
of privileges or memberships.

Equipment

Basic athletic equipment such as volleyballs, 
basketballs, etc. are available at no cost. A 
valid ID card must be handed in and you must 
be dressed in proper gym attire to acquire the 
equipment. Campus recreation may only be issued 
to the referee or person in charge of the activity. 
All equipment must be returned in good condition, 
or a charge may apply for repair or replacement.
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lockers

Day use only lockers. All locks must be removed at 
the end of the day. Locks not removed will be cut 
and the contents removed. The contents will be 
held in storage for only 30 days from the time of 
cutting. Locks are available for loan at the North 
Campus. 

Towels

Towels are available at no cost when a valid ID 
card is handed in. Workout towels are available 
in the weight room for fitness use, but must be 
returned upon leaving the fitness area.

north Campus room A116

Phone: 416.675.5097

Hours of operation: Monday to Friday  
6:30 a.m. – 10:00 p.m.

Saturday and Sunday 
8:00 a.m. – 5:00 p.m.

lakeshore Campus residence 142

Hours of operation: Monday to Friday  
6:30 a.m. – 10:00 p.m.

Saturday and Sunday 
10:00 a.m. – 4:00 p.m.
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ACADEmIC CAlEnDAr
2015/2016 Humber Postsecondary - Certificates, Diplomas and graduate Certificates

Humber Academic Calendar 2015/2016

 

Humber College Post-Secondary  
15 Week Semester

fall 2015

Orientation August 31-September 04, 2015

Public Holiday (Labour Day) - College Closed Monday, September 07, 2015

Day/Evening Classes Begin* Tuesday, September 08, 2015

Last Day to Add Monday, September 14, 2015

Balance of Fall Fees Due Monday, September 21, 2015

Last Day for Refund Monday, September 21, 2015

Public Holiday (Thanksgiving) - College Closed Monday, October 12, 2015

Mid Term Grades Due Friday, October 30, 2015

Winter 2016 Tuition Deposit Due Wednesday, November 04, 2015

Fall Convocation Thursday, November 05, 2015

Last Day to Withdraw without academic penalty Friday, November 13, 2015

Registration Opens for Winter 2016 First week of December 2015

Last Day of Classes Friday, December 18, 2015

Final Grades Due by Faculty Monday, December 21 (9:00pm)

Holiday Period-College will be closed at 12:00 noon Thursday, December 24, 2015

Humber College Post-Secondary  
15 Week Semester

Winter 2016

Public Holiday (New Year)- College Closed Friday, January 01, 2016

College Re-opens Monday, January 04, 2016

Orientation January 4 - 10, 2016

Day/Evening Classes Begin* Monday, January 11, 2016

Last Day to Add Friday, January 15, 2016

Balance of Winter Fees Due January 22, 2016

Last Day to Withdraw for Refund Friday, January 22, 2016

Earliest Date - Fall Graduation Status available Friday, February 12, 2016

Reading Week February 15 to 19, 2016

Public Holiday (Family Day) - College Closed Monday, February 15, 2016

Summer 2016 Tuition Deposit Due Wednesday, March 9, 2016

Mid Term Grades Due Friday, March 11, 2016

Last Day to Withdraw without academic penalty Thursday, March 24, 2016

Public Holiday (Good Friday) - College Closed Friday, March 25, 2016

Registration Opens for Summer 2016 Second Week of April 2016

Last Day of Classes Friday, April 29, 2016

Final Grades Due at noon by Faculty Tuesday, May 03, 2016
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Humber College Post-Secondary  
15 Week Semester

Summer 2016

Orientation May 02 - 06, 2016

Day/Evening Classes Begin* Monday, May 09, 2016

Last day to add a course Friday, May 13, 2016

 Balance of Summer Fees Due May 20, 2016

Last Day to Withdraw for Refund Friday, May 20, 2016

Public Holiday (Victoria Day) - College Closed Monday, May 23, 2016

Earliest Date - Winter Graduation Status available Friday, June 10, 2016

Convocation Week June 13-17

Fall 2016 Tuition Deposit Due TBD

Mid Term Grades Due - 8 Week Courses Friday, June 03, 2016

Mid Term Grades Due - 12 Week Courses Friday, June 17, 2016

Mid Term Grades Due - 15 Week Courses Thursday, June 30, 2016

Public Holiday (Canada Day) - College Closed Friday, July 01, 2016

Last Day to Withdraw without academic penalty Friday, June 17, 2016 (8 Week Courses)

Thursday, June 30, 2016 (12 Week Courses)

Friday July 15, 2016 (15 Week Courses)

Registration Opens for Fall 2015 First week of August 2016

Public Holiday (Civic Holiday) - College Closed Monday, August 01, 2016

Last Day of Class 8 Week Courses Thursday, June 30, 2016  (8 Week Courses)

Friday, July 29, 2016 (12 Week Courses)

Friday, August 19, 2016 (15 Week Courses)

Final Grades Due at noon by Faculty Tuesday, July 05, 2016 (8 Week Courses)

Wednesday, August 03, 2016(12 Week Courses)

Wednesday, August 24, 2016(15 Week Courses)

Earliest Date- Graduation Status available Friday, October 7, 2016

*Summer courses running in a non-standard term (other than 14-15 weeks), will have to calculate 
the last day of withdrawal using 66.66% into classes.

*Courses offered online or during the weekend may begin before this date.
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2015/2016 Humber Bachelor Degrees

Humber Academic Calendar 2015/2016

Humber College Bachelor Degrees 
14 Week Semester

fall 2015

Orientation August 31-September 04, 2015

Public Holiday (Labour Day) - College Closed Monday, September 07, 2015

Day/Evening Classes Begin* Tuesday, September 08, 2015

Last Day to Add Monday, September 14, 2015

Balance of Fall Fees Due Monday, September 21, 2015

Last Day for Refund Monday, September 21, 2015

Public Holiday (Thanksgiving) - College Closed Monday, October 12, 2015

Mid Term Grades Due Friday, October 23, 2015

Fall Convocation Thursday, November 05, 2015

Winter 2016 Tuition Deposit Due Wednesday, November 4, 2015

Last Day to Withdraw without academic penalty Friday, November 06, 2015

Registration Opens for Winter 2016 First week of December 2015

Last Day of Classes Friday, December 11, 2015

Final Grades Due by Faculty Wednesday, December 16, 2015

Holiday Period-College will be closed at 12:00 noon Thursday, December 24, 2015

Humber College Bachelor Degrees 
14 Week Semester

Winter 2016

Public Holiday (New Year)- College Closed Friday, January 01, 2016

College Re-opens Monday, January 04, 2016

Orientation Monday, January 4 - 10, 2016

Day/Evening Classes Begin* Monday, January 11, 2016

Last Day to Add Friday, January 15, 2016

Balance of Winter Fees Due Friday, January 22, 2016

Last Day to Withdraw for Refund Friday, January 22, 2016

Earliest Date - Fall Graduation Status available Friday, February 12, 2016

Reading Week February 15 to 19, 2016

Public Holiday (Family Day) - College Closed Monday, February 15, 2016

Mid Term Grades Due Friday, March 04, 2016

Summer 2016 Tuition Deposit Due Wednesday, March 9, 2016

Last Day to Withdraw without academic penalty Friday, March 18, 2016

Public Holiday (Good Friday) - College Closed Friday, March 25, 2016

Registration Opens for Summer 2016 Second Week of April 2016

Last Day of Classes Friday, April 22, 2016

Final Grades Due at noon by Faculty Wednesday, April 27, 2016
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Humber College Bachelor Degrees 
14 Week Semester

Summer 2016

Orientation May 02 - 06, 2016

Day/Evening Classes Begin* Monday, May 09, 2016

Last day to add a course Friday, May 13, 2016

Balance of Summer Fees Due Friday, May 20, 2016

Last Day to Withdraw for Refund Friday, May 20, 2016

Public Holiday (Victoria Day) - College Closed Monday, May 23, 2016

Earliest Date - Winter Graduation Status available Friday, June 10, 2016

Convocation Week June 13-17

Fall 2016 Tuition Deposit Due TBD

Mid Term Grades Due - 14 Week Courses Friday, July 08, 2016

Public Holiday (Canada Day) - College Closed Friday, July 01, 2016

Registration Opens for Fall 2015 First week of August 2016

Last Day to Withdraw without academic penalty Friday, July 08, 2016

Public Holiday (Civic Holiday) - College Closed Monday, August 01, 2016

Last Day of Class Friday, August 12, 2016

Final Grades Due at noon by Faculty Wednesday, August 17, 2016

Earliest Date- Graduation Status available Friday, October 7, 2016

*Summer courses running in a non-standard term (other than 14-15 weeks), will have to calculate 
the last day of withdrawal using 66.66% into classes.

*Courses offered online or during the weekend may begin before this date.
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2015/2016 unB-Humber Collaborative Bachelor of nursing

Humber Academic Calendar 2015/2016

Humber College unB  
13 Week Semester

fall 2015

Orientation August 31-September 04, 2015

Public Holiday (Labour Day) - College Closed Monday, September 07, 2015

Day/Evening Classes Begin* Tuesday, September 08, 2015

Last Day to Add Monday, September 14, 2015

Balance of Fall Fees Due Monday, September 21, 2015

Last Day for Refund Monday, September 21, 2015

Public Holiday (Thanksgiving) - College Closed Monday, October 12, 2015

Fall Convocation Thursday, November 05, 2015

Winter 2016 Tuition Deposit Due Wednesday, November 4, 2015

Last Day to Withdraw without academic penalty Friday, November 06, 2015

Last Day to hold an in class test Friday, November 20, 2015

Registration Opens for Winter 2016 First week of December 2015

Last Day of Classes Friday, December 04, 2015

UNB Nursing Exam/Evaluation Period December 8 - 18, 2015

Final Grades Due by Faculty Monday, December 21 (9:00pm)

Holiday Period-College will be closed at 12:00 noon Thursday, December 24, 2015

Humber College unB  
13 Week Semester

Winter 2016

Public Holiday (New Year)- College Closed Friday, January 01, 2016

College Re-opens Monday, January 04, 2016

Orientation January 4 - 10, 2016

Day/Evening Classes Begin* Monday, January 11, 2016

Last Day to Add Friday, January 15, 2016

Balance of Winter Fees Due Friday, January 22, 2016

Last Day to Withdraw for Refund Friday, January 22, 2016

Earliest Date - Fall Graduation Status available Friday, February 12, 2016

Reading Week February 15 to 19, 2016

Public Holiday (Family Day) - College Closed Monday, February 15, 2016

Summer 2016 Tuition Deposit Due Wednesday, March 9, 2016

Last Day to Withdraw without academic penalty Friday, March 18, 2016

Last Day to hold an in class test Friday, April 01, 2016

Public Holiday (Good Friday) - College Closed Friday, March 25, 2016

Registration Opens for Summer 2016 Second Week of April 2016

Last Day of Classes Friday, April 15, 2016

UNB Nursing Exam/Evaluation Period April 19 - April 29, 2015

Final Grades Due at noon by Faculty Tuesday, May 03, 2016

Intersession Nursing Practice - BN 2nd Year May 2 to May 29, 2015

Intersession Nursing Practice - BN 3rd Year May 3 to June 12, 2015
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Humber College unB  
13 Week Semester

Summer 2016

Orientation May 02 - 06, 2016

Day/Evening Classes Begin* Monday, May 09, 2016

Last day to add a course Friday, May 13, 2016

Balance of Summer Fees Due Friday, May 20, 2016

Last Day to Withdraw for Refund Friday, May 20, 2016

Public Holiday (Victoria Day) - College Closed Monday, May 23, 2016

Earliest Date - Fall Graduation Status available Friday, June 10, 2016

Convocation Week June 13-17

Fall 2016 Tuition Deposit Due TBD

Public Holiday (Canada Day) - College Closed Friday, July 01, 2016

Registration Opens for Fall 2015 First week of August 2016

Last Day to Withdraw without academic penalty Friday, July 08, 2016

Public Holiday (Civic Holiday) - College Closed Monday, August 01, 2016

Last Day of Class Friday, August 05, 2016

Final Grades Due at noon by Faculty Wednesday, August 10, 2016

Earliest Date- Graduation Status available Friday, October 7, 2016

*Summer courses running in a non-standard term (other than 14-15 weeks), will have to calculate 
the last day of withdrawal using 66.66% into classes.

*Courses offered online or during the weekend may begin before this date.
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STuDEnT fEEDBACk QuESTIonnAIrES (SfQS)

  1. The professor was well prepared for each class/lab.
  2. The professor presented his/her materials in a clear manner.
  3. The pace the professor set for the course was appropriate for me.
  4. The professor helped me think critically about the topics in the course.
  5. The professor used a variety of teaching methods (e.g., group work,  

multimedia, case studies, lecture, etc.).
  6. The professor treated me with courtesy.
  7. The professor provided clear explanation about how student work  

would be evaluated in the course.
  8. The way the professor taught helped me learn.
  9. The professor provided me with useful feedback about my progress.
10. The professor managed student classroom behaviour.
11. The professor motivated me to learn. 

12. The professor responded to my course-related voice message(s) or 
email message(s) within 2 school days.

13. The professor returned the assignments and tests within a  
2-week period.

14. Compared with other courses I have taken this semester, my effort  
In this course was…

15. Overall, the learning experience in this course was…

YOUR PROFESSOR’S QUESTIONS Answer any additional 
questions provided by your professor using bubbles 16-18.

STUDENT FEEDBACK QUESTIONNAIRE

The student Feedback Questionnaire is a means for students to provide information to faculty and administrators to  
acknowledge teaching excellence and strengthen teaching effectiveness. As such, it is a developmental / formative tool. 
Please answer thoughtfully and honestly by using the response scale provided for each question.

MARKING INSTRUCTIONS

See Back for Comments Section

INCORRECT

Not 
Applicable

Not 
Applicable

Strongly 
Agree

Strongly 
Agree

Always

Excellent

Almost 
Always

Above 
Average

Below 
Average

Rarely Never Not 
Applicable

Poor

Less than in Other 
Courses

The Same as in 
Other Courses

Greater than in Other 
Courses

SA A D SD NA

SA A D SD NA

SA A D SD NA

SA A D SD NA

SA A D SD NA

SA A D SD NA

SA A D SD NA

SA A D SD NA

SA A D SD NA

SA A D SD NA

SA A D SD NA

SA A D SD NA

SA A D SD NA

SA A D SD NA

CORRECT
ASA D SD NA ASA D SD NA

A AA R N NA

A AA R N NA

17.
16.

18.

E AA BA P

G S L

Agree

Agree

Disagree

Disagree

Strongly 
Disagree

Strongly 
Disagree

SFQ901(05/11)
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Your comments are highly valued and will assist the professor with this course.

What did you like about the course?

What would make this course a better learning experience?

COMMENTS
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kEY PErformAnCE InDICATorS (kPIs)

Important

satisfied

Very Satisfied

Satisfied

Dissatisfied

IMPORTANCE SATISFACTION

graduation.
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0 1 2 3 4 5 6 7 8 9
0 1 2 3 4 5 6 7 8 9
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following:

Important

satisfied

Very Satisfied

Satisfied

Dissatisfied

IMPORTANCE SATISFACTION

.

N

N

N

N

N

N

N

N

N

N

N

1

1

1

1

1

1
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4

4
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5

5

5
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.
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(continued)

Important

IMPORTANCE NOITCAFSITASEGASU
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1
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1 2 31 42 5

1 2 3 4 51 2

.
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1 2 3 4 5

1 2 3 4 5
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1 2 3 4 5
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4
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5

agree

Strongly Agree
Agree

Disagree
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Very Satisfied

Satisfied

Dissatisfied

3

3

3
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None

.

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5

1 2 3 4 5 6

6

6

6

6

6

Female
Male

1

1

1

1

1

1

2

2

2

2

2

2

3

3
4

3

3

4

5

4

6
7
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5

21-25
26-30
31-35

English
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Other
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Other

Other

7

7

7

7

7

7

humbsse11

.

1
2
3
4
5

Faculty

1
2
3
4
5
6

Satisfied

Dissatisfied

1 2Yes No

program?
1 2Yes No

programming.

1
2 Agree
3
4 Disagree
5
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 HumBEr CollEgE norTH  
CAmPuS (no) 
205 Humber College Blvd.  
Toronto, ON  M9W 5L7 
Tel: 416.675.5000  
enquiry@humber.ca

 Humber Arboretum 
North Campus 
Tel: 416.675.5009  
arboretum@humber.ca

 Humber Transportation Training  
Centre (GA)  
55 Woodbine Downs Blvd.  
Toronto, ON  M9W 6N5  
Tel: 416.798.0300  
truck.info@humber.ca

 Humber Centre for Trades & 
Technology (CAR)  
110 Carrier Drive  
Toronto, ON  M9W 5R1 
Tel: 416.675.5000  
enquiry@humber.ca

 HumBEr orAngEVIllE  
CAmPuS (or) 
Alder St.Recreation Complex  
275 Alder Street 
Orangeville, ON  L9W 5H6 
Tel: 416.675.5000 or 1.877.675.3111  
Fax: 519.941.8068  
http://humber.ca/orangeville/ 
enquiry@humber.ca

 Humber Arts & Media Studios (BIR) 
300 Birmingham Street  
Toronto, ON  M8V 2E6  
Tel: 416.675.5000  
enquiry@humber.ca

1.  Humber Launch 
3180 Lake Shore Blvd. West 
Toronto, ON  M8V 1L7 
Tel: 416.675.6622 ext.79250  
humberlaunch@humber.ca

 Community Medical Services  
Building (MED) 
3170 Lake Shore Blvd. West  
2nd Floor  
Toronto, ON  M8V 3X8  
Tel: 416.675.5000  
enquiry@humber.ca

 Humber Fashion Institute (FAS) 
3166 Lake Shore Blvd. West 
Toronto, ON  M8V 1L6 
Tel: 416.675.5000  
enquiry@humber.ca

 HumBEr lAkESHorE CAmPuS (lA) 
3199 Lake Shore Blvd. West 
Toronto, ON  M8V 1K8  
Tel: 416.675.5000  
http://humber.ca/lakeshorecampus/ 
enquiry@humber.ca

 Humber Centre for Justice  
Leadership (AN) 
3120 Lake Shore Blvd. West 
Toronto, ON  M8V 1L3 
Tel: 416.675.5000  
enquiry@humber.ca

 Humber Sailing & Powerboating 
Centre (SS) 
100 Humber Bay Park Rd. West  
Toronto, ON  M8V 3X7  
Tel: 416.252.7291  
sailing@humber.ca

TrAnSIT To HumBEr 

Brampton Transit/Züm 
905.874.2750  
brampton.ca/en/residents/transit 

Go Transit 
416.869.3200 
gotransit.com

MiWay (Mississauga Transit) 
905.615.4636 
mississauga.ca/portal/miway

Toronto Transit Commission (TTC) 
416.393.4636  
ttc.ca

York Region Transit (YRT)/Viva 
905.762.2100 
yorkregiontransit.com

Parking and campus maps are available 
at humber.ca/maps.

Map is not to scale.

2.

7.

8.

9.

10.

11.

12.

3.

4.

5.

6.

87

Fa
cu

lt
y 

Ha
n

d
bo

o
k 

20
15

-2
01

6

http://humber.ca/orangeville/
http://humber.ca/lakeshorecampus/
http://brampton.ca/en/residents/transit%20%20
http://gotransit.com%20
http://mississauga.ca/portal/miway%20
http://ttc.ca
http://yorkregiontransit.com%20
http://humber.ca/maps


DROP OFF

FLAGPOLES

CENTRE FOR 
URBAN ECOLOGY

HUMBER 
COLLEGE
CHILD CARE
CENTRE

Arboretum Turnaround

STUDENT
RESIDENCE

Humber North Campus
205 Humber College Blvd.

To
 Q

ue
en

’s 
Pl

at
e 

Pa
rk

in
g

SI
LV

ER
 B

EL
L 

LA
N

E

IE

A

SWIMMING
POOL

C

B

D

I

J

H

E

NX

KX
K

N

G

FX F

JF

LX

L

M

P

GH

W

S

R

U

EX

DX

LRC

Walkway

Bridge
(2nd floor)

Entrance
(2nd floor)

T

BIKE RACK

CAMPUS SECURITY DESK
416.675.8500

CAMPUS WALK ext. 8500

EMERGENCY 
TELEPHONE LOCATION

INFORMATION

HUMBER SHUTTLE BUS STOP
Queen’s Plate parking lot -  
September to April, Monday  
to Friday, 6:45 a.m. - 8 p.m.

PARKING (accessible)

PARKING SERVICES KIOSK
Lot 7 kiosk staffed Monday 
to Friday, 6:30 a.m. - 8 p.m.  
ext. 4416.

PAY STATION

PEDESTRIAN WALKWAY

TRAFFIC LIGHTS

TRANSIT (accessible)
Pick-up/Drop-off

TRANSIT (PUBLIC) STOP

REXDALE BOULEVARD

QUEEN’S PLATE DRIVE

Queen’s Plate
Parking

JA
ND

A 
CT

.  

WOODBINE CENTRE

Permit 
Parking 
and 
Pay-on- 
Exit Lot

H
U

M
BE

R 
CO

LL
EG

E 
BL

VD
.

FINCH AVENUE

CA
RR

IE
R 

D
RI

VE

W
O

O
D

BI
N

E 
D

OW
N

S 
BL

VD
.

TO HWY 427

CAR

CARRIER DRIVE

Westwood
Arena

GA

Humber Centre for
Trades & Technology

110 Carrier Drive

72 Y
W

H  

Humber Transportation 
Training Centre
55 Woodbine Downs Blvd.

ENTRANCE LOCATIONS

 Lot 1, 2, 3 – Permit Only
 Lot 4, 5, 6 – Pay-on-Exit

 Lot 7 – Parking Services and Guest Parking
 Lot 8 – Pay-on-Exit

 Lot 9 – Permit Only
 Lot 10 – Pay-on-Exit
 Lot 11 – Permit Only
 Lot 12 – Swimming Pool

 Lot 13, 14, 15 – Permit Only

04.15
MAP IS NOT TO SCALE

AT

AT

AT

CENTRAL
RECEIVING

HUMBER CHILD 
DEVELOPMENT CENTRE

UNIVERSITY OF
GUELPH-HUMBER

HUMBER 
LEARNING RESOURCE 

COMMONS

TO
 H

WY 2
7

HUMBER COLLEGE BLVD.
724 YWH & HCNIF OT

EVIRD ENILREB
MUH

BE
EC

H
 F

O
RE

ST
 D

R.

SP
RU

CE
 V

IS
TA

SPRUCE VISTA

AR
BO

RE
TU

M
 B

LV
D.

AR
BO

RE
TU

M
 B

LV
D.

ARBORETUM BLVD.

ARBORETUM BLVD.

 H
W

Y 
27

LOT 2

LOT 2

LOT 3

LOT
4

LOT 3

LOT 6LOT 8

LOT 
7

LOT 9

LOT 10
LOT 13

LOT
14

LOT 12

LOT 15

LOT 1

LOT 1

LOT 5

LOT 11

BUS LOOP

HumBEr norTH CAmPuS
205 Humber College Blvd., Toronto, Ontario  M9W 5L7

88

Fa
cu

lt
y 

Ha
n

d
bo

o
k 

20
15

-2
01

6



A
ABORIGINAL RESOURCE CENTRE .......................  LRC-2

ACADEMIC AND CAREER SUCCESS CENTRE  .....  LRC-1

ACADEMIC UPGRADING  ....................................  LRC-5

ACCESSIBILITY SERVICES  .................................  LRC-2

ACCOUNTING CENTRE (E221)  ..........................  E-2

ADMINISTRATIVE OFFICES

•	 President .....................................................  LRC-6

•	 Vice-Presidents ...........................................  LRC-6

ADMISSIONS .....................................................  LRC-1

ADVANCEMENT AND ALUMNI RELATIONS  .........  LRC-5

AMPHITHEATRE  .................................................  KX-1

ARBORETUM  .....................................................  ARB

ART GALLERIES

•	 Aboriginal Art ..............................................  E-1

•	 Guelph-Humber Gallery ...............................  GH-1

•	 Humber Gallery ............................................  LRC-1

ASSOCIATIONS AND PARTNERSHIP PROGRAMS

(LX104) .............................................................  LX-1

ATHLETICS & RECREATION

•	 Athletics Office (A116) ................................  A-1

•	 Community Pool ..........................................  AX-1

•	 Fitness Centre/Weight Room ......................  A-2

•	 Gymnasium .................................................  A-1

•	 Sports Injuries Clinic ...................................  A-1

ATRIUM  .............................................................  GH-1

AV GRAPHICS (D214) ........................................  D-2

B
BIOWALL ............................................................  GH-1

BOOKSTORE  ......................................................  H-1

BROADCAST CENTRE .........................................  L-2

C
CAMP CHOICE (LX104)  .....................................  LX-1

CENTRE FOR HUMAN RIGHTS, EQUITY AND 

DIVERSITY ..........................................................  LRC-5

CENTRE FOR TEACHING & LEARNING (D225) ...  D-2

CENTRE FOR URBAN ECOLOGY  .........................  U

CHILD CARE CENTRES ...................................FX-1/W-1

COMMUNITY OUTREACH AND WORKFORCE 

DEVELOPMENT  ..................................................  M-1

COMMUNITY ROOM (NX111)  ............................  NX-1

COMPUTER LABS (OPEN ACCESS)

•	 E-Link 1 .......................................................  H-2

•	 E-Link 2 .......................................................  N-2

•	 E-Link 3 .......................................................  LX-1

CONCOURSE ......................................................  E-1

CONFERENCE SERVICES  ...................................  R-1

COUNSELLING SERVICES ...................................  LRC-2

CULINARY ARTS & SCIENCES 
(Canadian Centre for)  .......................................  D-1

CULINARY ARTS DEMONSTRATION LAB  ............  E-1

CUSTOMER SERVICE  .........................................  LRC-1

•	 Admissions & Registration

•	 Financial Aid

D
DEAN OF STUDENTS ..........................................  LRC-2

DENTAL CLINIC (KX201) ....................................  KX-1

DESIGN CENTRE  ...............................................  N-1

DORIS TALLON ROOM (BASEMENT) ...................  K-B

E
EDUCATION & TRAINING SOLUTIONS (LX104) .. LX-1

f
FACILITIES MANAGEMENT (D134)  ....................  D-1

FINANCIAL AID/AWARDS ...................................  LRC-1

FINANCIAL SERVICES & PLANNING (B311)  ......  B-3

FIRST AID (SEE HEALTH CENTRE/SECURITY)

FOOD SERVICES

•	 Ackee Tree ...................................................  E-1

•	 Food Emporium (BASEMENT)......................  K-B

•	 Gourmet Express .........................................  E-1

•	 Hawk’s Nest .................................................  C-1

•	 Pizza Pizza

•	 Second Cup

•	 Humber Room ..............................................  EX-1

•	 Java Jazz ......................................................  H-1

•	 Staff Lounge (K217) ....................................  K-2

•	 LinX Lounge  ................................................  LX-1

•	 Residence Café ...........................................  R-1

•	 Starbucks ....................................................  LRC-1

•	 Tim Hortons .................................................  IE-1

•	 Williams Coffee Pub ....................................  GH-2

g
GAMES ROOM (BASEMENT)  .............................  KX-B

GOVERNORS’ BOARDROOM ...............................  LRC-6

GREENHOUSES ..................................................  G-1

H
HEALTH CENTRE/NURSE ....................................  LRC-2

HUMAN RESOURCES  ........................................  LRC-6

HUMBER SPA .....................................................  A-1

HUMBER STUDENTS’ FEDERATION (HSF) ..........  KX-2

I
INTERNATIONAL CENTRE ....................................  LRC-2

IT SUPPORT CENTRE (NX210)  ...........................  NX-2

l
LANDSCAPE TECHNOLOGY .................................  G/P

LIBRARY ........................................................  LRC-3&4

LECTURE THEATRE (E135)  ................................  E-1

LOST & FOUND (SECURITY DESK)  ....................  NX-1

m
MAILROOM (BASEMENT)  ..................................  N-B

MARKETING AND COMMUNICATIONS  ...............  LRC-6

MASSAGE THERAPY CLINIC................................  A-1

MATH CENTRE ....................................................  LRC-3

o
OPEN LEARNING CENTRE/LAB (D225)..............  D-2

P

PEER ASSISTED LEARNING SUPPORT  ...............  LRC-3

PRESIDENT’S BOARDROOM ...............................  LRC-6

PRESIDENT’S OFFICE .........................................  LRC-6

PRINT & COPY SHOP (H106)  .............................  H-1

PROGRAM PLANNING, DEVELOPMENT AND 
RENEWAL ...........................................................  LRC-6

PUBLIC SAFETY OFFICE (D153)  ........................  D-1

PURCHASING SERVICES (B314)  .......................  B-3

r
RECEIVING (BASEMENT)  ...................................  N-B

RECRUITMENT (STUDENT)  ................................  LRC-1

REGISTRAR’S OFFICE .........................................  LRC-1

REGISTRATION (CUSTOMER SERVICE) ...............  LRC-1

RESEARCH (INSTITUTIONAL)  ............................  LX-1

RESIDENCE LIFE  ...............................................  R-1

S
SCHOOL OFFICES

•	 Applied Technology (H221/J230) ...............  H-2/J-2

•	 Business (E205) .........................................  E-2

•	 Health Sciences (M200) .............................  M-2

•	 Hospitality, Recreation & Tourism (C105) ...  C-1

•	 Liberal Arts & Sciences ...............................  LRC-5

•	 Media Studies & Information 
Technology(K107)  ......................................  K-1

SECURITY DESK (HUMBER) ...............................  NX-1

•	 Campus Walk

•	 First Aid

•	 Lost & Found

SEVENTH SEMESTER (BASEMENT)  ...................  K-B

SPA  ...................................................................  A-1

STRATEGIC PLANNING AND INSTITUTIONAL  
ANALYSIS  ..........................................................  LRC-6

STUDENT CENTRE  .............................................  KX

STUDENT EVENTS (D149)  .................................  D-1

STUDENT RESIDENCES ......................................  R/S/T

STUDENT SUCCESS & ENGAGEMENT 
(STUDENT SERVICES)

•	 Aboriginal Resource Centre .........................  LRC-2

•	 Student Life .................................................  LRC-2

•	 First Year Experince .....................................  LRC-2

•	 First in the Family ........................................  LRC-2

•	 Multi-Faith Centre  ......................................  LRC-2

•	 Orientation  .................................................  LRC-2

•	 Student Conduct  ........................................  LRC-2

•	 Transition and Leadership ...........................LRC-2

•	 Student Wellness and Accessibility Centre . LRC-2

•	 Accessibility Services ..................................  LRC-2

•	 Counselling  .................................................  LRC-2

•	 Health Centre ..............................................  LRC-2

•	 Peer Assisted Learning Support ..................LRC-3

T
TESTING SERVICES  ...........................................  LRC-2

TOURS  ...............................................................  LRC-1

u
UNIVERSITY OF GUELPH-HUMBER  ....................  GH

URBAN ECOLOGY CENTRE  .................................  U

W
WRITING CENTRE ...............................................  LRC-3

Y
YOUTH ENRICHMENT PROGRAM (LX104)  .........  LX-

B - Basement / 1 - main floor / 2 - 2nd floor / 3 - 3rd floor / 4 - 4th floor / 5 - 5th floor / 6 - 6th floor 
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A

AX

Student Residence

B

B

Humber Lakeshore Campus – East
(Robert A. Gordon Learning Centre)

Humber Lakeshore Campus – West
3199 Lake Shore Boulevard West

(Buildings A, AX, B, R)

Assembly Hall Parking 

C D E
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IJK
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Redmond
Secondary

School
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Humber 
Centre for Justice Leadership

3120 Lake Shore Blvd. W.

LOT 5

LO
T 

4

Walkway to Humber Lakeshore Campus - East

CENTRAL RECEIVING

N
Visitor and

Permit Parking

LOT 1

LOT 1
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or 
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 Aged
 

City of Toronto
Assembly Halll
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R
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TH
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T

22
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22

N
D
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BIRMINGHAM STREET

Humber 
Arts & Media Studios
300 Birmingham Street

FAUSTINA DRIVE

FA
U

ST
IN

A 
D

R
IV

E

Gus Ryder
Pool

Lakeshore
Collegiate
Institute

BIR

FASMED

Humber Fashion Institute
3166 Lake Shore Blvd. W.

Community Medical
Services Building

3170 Lake Shore Blvd. W.

IHI

Innovation
Humber Incubator

3180 Lake Shore Blvd. W.

M&C - 04.13
MAP IS NOT TO SCALE

CAMPUS SECURITY DESK

416.675.8500
CAMPUS WALK ext. 8500

EMERGENCY 
TELEPHONE LOCATION

ENTRANCE

PARKING (accessible)

PARKING SERVICES KIOSK

PEDESTRIAN WALKWAY

PUBLIC TRANSIT STOP

TRAFFIC LIGHTS

WHEEL TRANS
Public Transit Pick-up/Drop-off

  BUILDING ADDRESSES 

 C 7 Colonel Samuel Smith Park Drive

 D 9 Colonel Samuel Smith Park Drive

 E 11 Colonel Samuel Smith Park Drive

 F 15 Colonel Samuel Smith Park Drive

 G 17 Colonel Samuel Smith Park Drive

 H 23 Colonel Samuel Smith Park Drive

 I 25 Colonel Samuel Smith Park Drive

 J 27 Colonel Samuel Smith Park Drive

 K 29 Colonel Samuel Smith Park Drive

 L 19 Colonel Samuel Smith Park Drive

 M 21 Colonel Samuel Smith Park Drive

 N Central Plant/Receiving and Mailroom
  (below ground)

L

LEGEND

HumBEr lAkESHorE CAmPuS
3199 Lake Shore Blvd. W., Toronto, Ontario  M8V 1K8

Buildings A, Ax, B and r

Accessible Learning Services  ...............................  A120

Admissions  ...........................................................  A118 

Auditorium .............................................................  A128

Bookstore  .............................................................  R134

Cafeteria  ...............................................................  A

Counselling  ...........................................................  A120

Customer Service ..................................................  A118

CTL Creative Studio  ..............................................  A112 

Financial Aid  .........................................................  A118

Fitness Centre .......................................................  R

Gymnasium  ...........................................................  A

Liberal Arts & Sciences Office  ..............................  A114

Library  ...................................................................  B

Lost and Found  .....................................................  A110

Media Centre (second floor)  .................................  A

Music Department Office  ......................................  A101

Percussion Studio  .................................................  A122

Principal’s Office  ...................................................  A110

Recording Studio  ..................................................  AX

Registration  ..........................................................  A118

Registrar’s Office  ..................................................  A118

Testing Services  ....................................................  A235

Buildings C, D, E, f, g, H, I, J, k, l, m and n

Social & Community Services 
Office/Classrooms .................................................  C

Creative & Performing Arts Office/Classrooms .....  D

Classrooms/Faculty Offices/Labs  ........................  E

Media Studies & Information Technology 
Office/Math & Writing Centre/Media Buzz Cafeteria/
Classrooms/Labs/Centre for Teaching and 
Learning................................................... F

Future Development ..............................................  G

Business School Office/International Centre/Accounting Centre/
Health Centre/Career Centre/Peer Tutoring/Prayer Room 
 H

Classrooms/Faculty Offices/Labs  ........................  I

English Language Centre/Liberal Arts & Sciences Faculty Offices/
Classrooms/English for Academic Purposes (EAP) Labs  
 J

Student Centre/Humber Students’ Federation Office/

Games Room  ........................................................  K

Lakeshore Commons/Cafeteria/Broadcast Centre/

Classrooms/Labs/Tours  .......................................  L

Security/Facilities Management/Tim Hortons  .....  M

Central Plant/Receiving/Mailroom 

(below ground)  .....................................................  N
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Conservation
Area
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 T
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IF

TOWNLIN
E
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DAW
SON RDRIDDELL RD

B LINE

BROADWAY

TOWNLIN
E

HumBEr orAngEVIllE CAmPuS
275 Alder St., Alder Street Recreation Complex, Orangeville, Ontario  L9W 5H6

275 Alder Street

Orangeville, ON  L9W 5H6

Tel: 416.675.5005 or 

 1 877.675.3111

Fax: 519.941.8068

http://humber.ca/orangeville/ 
enquiry@humber.ca
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frEQuEnTlY CAllED numBErS 
Department Telephone Extension

Aboriginal Services (North) 416.675.6622 ext. 5424 

ext. 5675

Accessible Learning Services (North) 416.675.5090 

Accessible Learning Services (Lakeshore) 416.675.6622 ext. 3331

Accounting Centre (North) 416.675.6622 ext. 4929 

ext. 5503

Accounting Centre (Lakeshore) 416.675.6622 ext. 3889

Advancement & Alumni Relations 416.673.0152 

Awards & Scholarships 416.673.0152 

Arboretum (Nature Centre) 416.675.6622 ext. 5009

Athletics (North) 416.675.5097 

Athletics (Lakeshore) 416.675.6622 ext. 3237

Athletics (Swimming Pool) 416.394.6050 

Call Centre/Customer Service 416.675.6622 

Catering Services 416.675.6622 ext. 4238

Camp Choice (North/Lakeshore) 416.675.6622 ext. 4735

Campus Bookstore - Follett (North) 416.675.5066 

Campus Bookstore - Follett (Lakeshore) 416.675.6622 ext. 3236

Campus Pharmacy (North) 416.675.6622 ext. 8503

LinX Pub 416.675.5003 

Career Service Centre (North) 416.675.5030 

Career Service Centre (Lakeshore) 416.675.5028 

Centre for Employee Benefits (401 The West Mall) 416.675.5047 

Centre for Teaching & Learning 416.675.6622 ext. 5040

Chaplaincy Services (North/Lakeshore) 416.675.6622 ext. 4427

Child Care Centre (North) 416.675.5073 

Child Development Centre (North) 416.675.5057 

Conference Services 416.675.5027 
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Education Training Solutions (North) 416.674.2472 

Counselling - Educational and Psychological (North) 416.675.5090 

Counselling - Educational and Psychological (Lakeshore) 416.675.6622 ext. 3331

Dental Clinic (North) 416.675.6622 ext. 4166

Development Office (North) 416.675.6622 ext. 5480

Evening Bus Service 416.675.6622 ext. 4416

Facilities Management (North/Lakeshore) 416.675.6622 ext. 4444

Financial Assistance - OSAP (North) 416.675.3111 option 4

Financial Assistance - OSAP (Lakeshore) 416.675.3111 option 4

Government & Community Relations 416.675.5042 

Health Centre (North) 416.675.6622 ext. 4533

Health Centre (Lakeshore) 416.675.6622 ext. 3234

HR Services 416.675.6622 ext. 4393

HR Services - Employment Inquiries 416.675.5088 

Humber Press 416.675.5000 ext. 5237

Humber Room (Direct Line) 416.675.5022 

Humber Spa 416.675.5033 

Humber Students Federation (North) 416.675.5051 

Humber Students Federation (Lakeshore) 416.675.6622 ext. 3382

Grenville Copy Centre 416.675.6622 ext. 4228

International Office 416.675.5067 

Libraries (North) 416.675.5079 

Libraries (Lakeshore) 416.675.6622 ext. 3247

Libraries (Orangeville) 416.675.6622 ext. 5909

Math Centre (North) 416.675.6622 ext. 76259

Math Centre (Lakeshore) 416.675.6622 ext. 73663

Open Learning Centre 416.675.5049 

Orangeville - Front Desk 416.675.6622 ext. 5902
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Parking Services 416.675.6622 ext. 4416

Peer Tutoring (North) 416.675.6622 ext. 4616

Peer Tutoring 416.675.6622 ext. 3340

Planning & Development Office 416.675.5061 

Principal Lakeshore 416.675.6622 ext. 3332

Public Safety (North) 416.675.6622 ext. 8500

Public Safety (Lakeshore) 416.675.6622 ext. 3240

Public Safety (Tol-Free-Cell) 416.675.8500 

Purchasing 416.675.5050 

Radio Humber (Campus Radio Station) 416.675.6622 ext. 4913 

(Station 

Manager)

Registrar's/Enrolment Mgmt.Services 416.675.5005 

School of Applied Technology (Front Desk for Faculty Office) 416.675.6622 ext. 4888

School of Applied Technology (Technical Corporate Training) 416.675.6622 ext. 4567

School of Applied Technology (Arboretum and Ecology Centre) 416.675.6622 ext. 5009

School of Applied Technology (Carrier Campus) 416.675.6622 ext. 78066

School of Applied Technology (Front Desk for Administrative 

Office) 

416.675.5010 

School of Applied Technology (Continuing Education) 416.675.5094 

School of Creative & Performing Arts (Sanja Antic - Music) 416.675.6622 ext. 3427

School of Creative & Performing Arts (Joe Bowden - Acting for 

Film & Television and Theatre) 

416.675.6622 ext. 79052

School of Creative & Performing Arts (Hilary Higgins - 

Humber School for Writers and Comedy) 

416.675.6622 ext. 3449

School of Creative & Performing Arts (Cynthia Good - 

Creative Book Publishing) 

416.675.6622 ext. 3462

School of Health Sciences (Bachelor of Nursing) 416.675.6622 

School of Health Sciences (Bachelor of Nursing Continuing 

Education) 

416.675.6622 ext. 4975

School of Health Sciences (Practical Nursing) 416.675.6622 ext. 4282
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School of Health Sciences (Continuing Education Nursing 

Certificates) 

416.675.6622 ext. 4078 

ext. 5868

School of Health Sciences (ECE Full-Time) 416.675.6622 ext. 4339

School of Health Sciences (ECE Continuing Education) 416.675.6622 ext. 5058

School of Health Sciences (Continuing Education) 416.675.6622 ext. 4868

School of Health Sciences (Allied Health) 416.675.6622 ext. 4462

School of Health Sciences (Emergency Skills) 416.675.6622 ext. 5784

School of HRT (Hospitality, Recreation & Tourism) 416.675.5012 

School of Liberal Arts & Science 416.675.6622 ext. 74313

School of Media Studies 416.675.6622 ext. 4111

School of Media Studies (Digital Imaging) 416.675.6622 ext. 4552

School of Social & Community Services 416.675.6622 ext. 3259

I.T.Support Centre (North/Lakeshore) 416.675.6622 ext. 8888 

ext. 4786 (From 

Residence)

Student Recruitment (North) 416.675.6622 ext. 4048

Student Residence (North) 416.675.6622 ext. 77200

Student Residence (Direct-line) 416.675.3413 

Student Residence (Lakeshore) 416.675.6622 ext. 73001

Student Success & Engagement 416.675.6622 ext. 4872

Testing Services (North) 416.675.6622 ext. 4712

Testing Services (Lakeshore) 416.675.6622 ext. 3228

Theatre Humber 416.675.6622 ext. 79052

The Business School (North) 416.675.6622 ext. 4391

The Business School (Lakeshore) 416.675.6622 ext. 3358

Transportation Training Centre 416.798.0300 

Writing Centre (North) 416.675.6622 ext. 76261

Writing Centre (Lakeshore) 416.675.6622 ext. 73313
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Microsoft® 

Outlook 2010 
Quick Reference Guide 
The Outlook 2010 Screen Navigation Pane 

zas  

 
Contains mail-related folders like your Inbox, 
Sent Items, and Search Folders. Use the 
Favorites section at the top of the pane for easy 
access to frequently-used folders. 

 
Enables you to view and schedule 
appointments, event, and meetings. View 
shared calendars and compare calendars by 
viewing them side-by-side. 

 
Store and keep track of addresses, phone 
numbers, and e-mail addresses. 

 
Organize to-do lists, track task progress, and 
delegate tasks. 
Notes: Use like electronic Post-It® Notes to write 
down information. 
Folder List: Displays a list of all your Outlook 
folders. 
Shortcuts: Add shortcuts to folders and 
locations in Outlook for quick access. 

 Keyboard Shortcuts 
Save <Ctrl> + <S> 
Preview and Print <Ctrl> + <P> 
Undo <Ctrl> + <Z> 
Cut <Ctrl> + <X> 
Copy <Ctrl> + <C> 
Paste <Ctrl> + <V> 
Check Spelling <F7> 
Check for Mail <F9> 
Save, Close, <Alt> + <S> 
and Send 
Reply <Ctrl> + <R> 
Reply to All <Alt> + <L> 
Address Book <Ctrl> + 

<Shift> + <B> 
Help <F1> 
Switch Between <Alt> + <Tab> 
Applications 
New Item <Ctrl> + <N> 
Search <Ctrl> + <E> 

The Fundamentals Mail: Basics 

 The File tab menu and Backstage view contain commands for 
working with a program’s files, such as Save As, Save 
Attachments, Close, New, and Print.  

 

 

 To Create a New Message:  
1. Click the New E-mail button in the 

New group of the Home tab on the 
Ribbon. Or, press <Ctrl> + <N>. 

2. Enter the e-mail address(es) in the To: 
box, or click the To button to use the 
Address Book. 

3. Click the Cc: or Bcc: buttons and 
enter the e-mail address(es) for whom 
you want to send copies of the 
message. 

4. Enter the subject of the message in 
the Subject box. 

5. Enter the text of your message in the 
text box. 

6. Click the Send button. 
 To Reply to a Message: Select/open the 

message, click the Reply button, type 
your reply, and click the Send button. 

 To Forward a Message: Select/open the 
message, click the Forward button, enter 
the e-mail address(es) in the To field, 
enter comments in the Body area, and 
click the Send button. 

 To Delete a Message: Select the 
message and press the <Delete> key. 

 To Open a Message: Click a message 
to view it in the Reading Pane or double-
click the message to open it. 

Reading Pane 

File tab 

Quick Access Toolbar Title bar 

People 
Pane 

Ribbon

To Do Bar

Close button

Navigation 
Pane 

Status Bar      

Messages Zoom 

 To Check for New Messages: Click 
the Send/Receive All Folders button 
or press <F9>. 

 To Preview and Print a Message: 
Click the File tab and select Print, or 
press <Ctrl> + <P>. 

 Message Indicators: 
 Message has not been read. 
 Message has been read. 

 File is attached to the message. 
  Message has high or low 

importance. 

 To Minimize the Ribbon: Click the 
Minimize Ribbon button on the 
Ribbon. Or, press <Ctrl> + <F1>. Or, 
right-click a tab and select Minimize 
Ribbon from the contextual menu. 

 To Change Account Settings: 
Click the File tab and select Open. 
Click the Account Settings button. 

 To Change Program Settings: 
Click the File tab and select Options. 

 To Get Help: Press <F1> to open 
the Help window. Type your question 
and press <Enter>. 

Information Technology Services
416.675.6622 X8888 | http://its.humber.ca

H
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Mail: Advanced Tasks  

 To Attach a File to a Message: Click the Attach Item button in the Include 
group of the Message tab in the Message window. 

 To Preview an Attachment: Click the attachment in the message preview in 
the Reading Pane. 

 To Open an Attachment: Double-click the attachment in the Reading Pane. 
The file opens in its default program. 

 To Flag a Message as a To-Do Item: Right-click the message, select Follow 
Up from the contextual menu, and select a flag. Or, click the  flag icon on 
the message. Or, select the message, click the  Follow Up button on the 
Standard toolbar and select a flag. 

 To Categorize a Message by Color: Click the  Quick Click icon on the 
message. Or, right-click the message, select Categorize from the contextual 
menu, and select a color category. Or, select the message, click the 
  Categorize button in the Tags group of the Home tab on the Ribbon, and 
select a flag. 

 To Recall a Message: Open the Sent Items folder. Double-click the 
message, click the Actions button in the Move group of the Message tab on 
the Ribbon, and select Recall This Message. Choose to delete the message 
or replace the message with a new one in the dialog box and click OK. You 
can only recall a message if you are using MS Exchange Server and the 
recipient has not opened it. 

 To Resend a Message: Open the Sent Items folder. Double-click the 
message, click the Actions button in the Move group of the Message tab on 
the Ribbon, and select Resend This Message. Edit the message and 
recipients as necessary and click Send. 

 To Create a Contact Group: Click the New Items button in the New group 
on the Ribbon and select More Items > Contact Group. Click the Add 
Members button in the Members group on the Ribbon, select a name in the 
list, click the Members button, and repeat for each name to be added. Click 
OK, then click Save & Close in the Actions group of the Contact Group tab. 

 To Create a Signature: In the message window, click the Signature button in 
the Include group of the Message tab on the Ribbon, select Signatures, and 
create the new signature. 

 To Change a Message’s Options: In the message window, click the 
Options tab on the Ribbon and click the More Options  dialog box 
Launcher. Here you can specify: if the message is important or sensitive; 
importance or sensitivity of the message; if you want to add voting buttons to 
the message; where replies should be sent to; if you want a read receipt; and 
if you want to encrypt the message or delay its delivery. 

 To Move a Message to a Different Folder: Select the item, click the Move 
button in the Move group of the Home tab of the Ribbon, and select the 
destination folder. Or, click and drag the item to a different folder in the 
Navigation Pane. 

 To Turn On the Out of Office Assistant: Click the File tab, select Info and 
click the Automatic Replies button. 

 To Save a Message as a Draft: Click the Save button on the Quick Access 
Toolbar in the message window. The message appears in the Drafts folder. 

 To Create a New Rule: Click the Rules button in the Move group of the 
Home tab on the Ribbon and select Create Rule.  

 To Manage Rules: Click the Rules button in the Move group of the Home tab 
on the Ribbon and select Manage Rules and Alerts. 

 Calendar 
 To Open the Calendar: Click the Calendar button in the Navigation Pane. 

 To Change Views: Click a view option in the Arrange group on the Home 
tab, or click the View tab and select an option there. 

 To View a Specific Date: Click the date in the Date Navigator, or click and 
drag to view a set of consecutive dates. 

 To Schedule an Appointment: Click the New Appointment button in the 
New group on the Home tab or press <Ctrl> + <N>. 

 To Schedule a Recurring Appointment: Click the New Items button in the 
New group on the Ribbon, and select More Items > Recurring 
Appointment. 

 To Schedule a Meeting: Click the New Meeting button in the New group on 
the Ribbon. Add recipients and meeting details and click Send. 

 To Schedule an All Day Event: Click the New Items button in the New group 
on the Ribbon and select All Day Event. 

 To Reschedule an Item: Click and drag the item to a new date and/or time 
on the Calendar. Or, double-click the item to open it, make your changes, and 
click the Save & Close button in the Actions group on the Ribbon. 

 To Edit an Item: Click the item to view the Calendar Tools contextual tab. Or, 
double-click the item, make your changes, and click the Save & Close button 
in the Actions group on the Ribbon. 

 To Delete an Item: Select the item and press <Delete>. Or, select the item 
and click the Delete button in the Actions group of the Appointment tab on the 
Ribbon. 

 To Search the Calendar: Click in the Search box in the upper right corner, or 
press <Ctrl> + <E>. Type search keywords and press <Enter>. 

 Contacts 
 To Open Contacts: Click the Contacts button in the Navigation Pane. 

 To Change Views: Click a view option in the Arrange group on the Home 
tab, or click the View tab and select an option there. 

 To Create a New Contact: Click the New Contact  button in the New group 
on the Home tab or press <Ctrl> + <N>. 

 To Create a New Contact Group: Click the New Contact Group button in 
the New group of the Home tab on the Ribbon. Click the Add Members button 
in the Members group on the Ribbon, select a name in the list, click the 
Members button and repeat for each name to be added. Click OK, then click 
Save & Close in the Actions group of the Contact Group tab. 

 To Edit a Contact: Double-click the contact and make your changes. 

 To Find a Contact: Type your search text in the Search Contacts field or 
press <Ctrl> + <E>. Or, click the Find a Contact field in the Find group on the 
Home tab, enter your search text and press <Enter>.  

 To Delete a Contact: Select the contact and press <Delete>. 

 Tasks and To-Do Items 
 To Open Tasks/To-Do List: Click the Tasks button in the Navigation Pane 

and select To-Do List or Tasks in the Navigation Pane. 
 To Create a New Task/To-Do Item: Click the New Task button in the New 

group on the Home tab or press <Ctrl> + <N>. 
 To Complete a Task: Click the Mark Complete button in the Manage Task 

group on the Ribbon, or click the task’s check box in Simple List view. 
 To Delete a Task: Select the task and press the <Delete> key. Or, click the 

Delete button in the Delete group of the Home tab. 
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unIfIED CommunICATIonS

Internal Dial the extension

Local Dial 9 + 
local number

Local 
Distance

Dial 9 + 1 +
local number

International
Dial 9 + 011 + 
number + # + 
Access Code 
(when requested)

Emergency Dial 911
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Telephone
Quick Reference Guide

Layout
Logging In
• Press Applications button.
• Select ExtensionMobility.
• Enter your user ID and PIN 

(provided by your system 
administrator).

Answering Calls
Using the Handset
• If the Handset is already lit, press 

the Answer softkey or the 
flashing line button.

Using the Headset
• Press the unlit Headset .

Using the Speaker
• Press the Speakerphone

button.
• Press the Answer softkey or 

select a flashing line button.

Placing Calls

Searching the Directory Mobile Transfer
• Press the Contacts button to access the personal 

directory, corporate directory or call history.

• Use the Navigation pad to select which directory to 
search.

• Enter first or last name using the dial pad.  Keep pressing 
a number key to toggle between letters.

• Use the X softkey to backspace one or more letters.
• Press the Search softkey to search.

• Use the Navigation pad to highlight the person you 
would like to call.

• Press the Dial softkey to automatically call the number.

Move a Desk Phone Call to a Mobile Phone
• Press the rightmost softkey to view more options.
• Press the Mobility softkey.
• Select the To Mobile softkey.
• Answer the in-progress call on your mobile phone.

Move a Mobile Call to the Desk Phone

• Select a line on your desk phone.
• Hang up the call on your mobile phone to disconnect 

the mobile phone but not the call.
• Press the Resume softkey on your desk phone within 5 

to 10 seconds and start talking on the desk phone.

 

Feature Buttons
Each button 
corresponds with a 
phone line, speed dial or 
calling feature.

Session Buttons
Each button corresponds with an active call or 
a call function depending on the state of the 
phone.  Coloured LEDs on the button reflect 
the call state: flashing amber for a ringing call, 
solid green for a connected call.

Handset
With red light strip which lights 
up to indicate an incoming call 
(flashing) or a new voicemail 
(solid).

Softkey Buttons
Activates options for the selected call or 
the menu item.

Navigation Pad
Press one of the dots on the outer ring to move up, 
down, left or right in a menu.  Press the grey button in 
the middle to make a selection.

Messages Button
Dials the voicemail system.

Applications Button
Opens/closes the Applications menu.  
Accesses preferences, call history 
and phone information.

Contacts Button 
Accesses the personal and corporate 
directories.

Volume Control
Controls the call volume if used while 
the handset is off-hook.  Controls the 
ringer volume if used while the 
handset is on-hook. 

 

Hold Button
Allows you to put an active 
call into a held state.

Transfer Button
Allows you to redirect a 
connected call from your 
phone to another number.

Conference Button
Allows you to add another 
party to the current call.

Headset Button
Allows use of your phone in Headset 
mode.

Speakerphone Button
Allows use of your phone in 
Speakerphone mode.

Mute Button
Switches the microphone muting on 
and off. 
 

Back Button
Returns to the 
previous screen or 
menu.

Release
Ends a connected call 
or session.

Keypad
Press keys to dial phone
numbers, enter letters or 
choose menu items. 

Phone Screen 
Shows information 
about your phone.
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Managing Calls Audio Conferencing
Placing a Call on Hold
• If you have more than one call on the line, the call you want 

to place on hold should be highlighted.

• Press the Hold button.  The call is now on hold.
• To resume the call, the call you want to resume should be 

highlighted.
• Press the Resume softkey to release the call from hold. 

Switching Between Calls
• While on a call, press the Answer softkey or a flashing line 

button.
• The first call will automatically be placed on hold and you will 

be connected to the second call.
• After you hang up or place the second call on hold, press the 

Resume softkey, returning you to the first call.
• If there is more than one call on hold, ensure that you select 

the appropriate call before you press the Resume softkey.

Transferring a Call
Transfer a call without speaking to the transfer recipient

• With a connected call, press the Transfer button and 
enter the target number.

• When you hear ringing, press the Transfer button 
again to transfer the call to the target number.

Talk to the transfer recipient before transferring the call

• With a connected call, press the Transfer button and 
enter the target number.

• If the recipient is willing to accept the call, press the Transfer

button again to transfer the call to the target number.
• If you decide not to transfer the call, press the Resume

softkey to return to the original call.

Forwarding all Calls
To redirect all of your incoming calls to another internal 
phone or local number
• Press the Forward all softkey.  Your phone may beep twice.
• Enter the extension or phone number to which your incoming 

calls should be forwarded.
• The forwarding number is now displayed on the top of your 

screen. All incoming calls will be routed to this number until 
you cancel call forwarding.

To forward your calls to voicemail
• Press the Forward all softkey.  Your phone may beep twice.

• Press the Messages button.
• The forwarding number is now displayed on the top of your 

screen. All incoming calls will be routed to this number until 
you cancel call forwarding.

To cancel Call Forwarding
• Press the Forward off softkey.

You must have a connected call to use the feature.

• Press the Conference button to add another 
party to the call.

• Enter the phone number of the conference 
participant.

• After the call connects, speak to the conference 
participant and then press the Conference button to 
add another party to the call.

• Repeat the process to add additional participants to 
the conference call.

Customizing Your Telephone
Change the Font Size
• Press the Applications button.

• Use the Navigation pad to:
− highlight and select Settings.
− highlight and select Font size.
− highlight and select the desired size.

• Press the Set softkey to confirm your choice.
• Press the Exit softkey twice.

Change the Wallpaper
• Press the Applications button.

• Use the Navigation pad to:
− highlight and select Settings.
− highlight and select Wallpaper.
− highlight and select the desired image.

• Press the Set softkey to save the setting.
• Press the Exit softkey twice.

Customize the Ring Tone
• Press the Applications button.

• Use the Navigation pad to:
− highlight and select Settings.
− highlight and select Ringtone.
− highlight and hear the selected sound.

• Press the Set softkey to save the setting.
• Press the Exit softkey twice.

Customize the Screen Contrast
• Press the Applications button.

• Use the Navigation pad to:
− highlight and select Settings.
− highlight and select Brightness.
− adjust the level of brightness.

• Press the Save softkey to save the setting.
• Press the Exit softkey twice.

REV: 2015-07-02
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Message Waiting Indicator – With red light strip which lights up 
to indicate an incoming call (flashing) or a new voicemail (solid).
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Voicemail
Quick Reference Guide

Logging In

 
 

Access Unified Messaging by Phone

• Press the Messages button on your phone.
• Enter your voicemail PIN and press #.

If you are working from another internal phone:
• Dial 5100
• Press * to interrupt the initial greeting and start the 

messages prompt.  
• Enter your mailbox ID when prompted and press #.  
• Enter your voicemail PIN and press #.

If you are working from off campus:
• Dial 416.673.6711
• Enter your mailbox ID when prompted and press #.
• Enter your voicemail PIN and press #.

Key Sequences

Main Menu

Hear new messages 1
Send a message 2
Review saved messages 3 1
Change setup options 4
Change greetings 4 1
Turn alternate greeting on or off 4 1 2
Change message notification 4 2 1
Change recorded name 4 3 2

After Recording a Message

Send message #
Add name 9 1
Mark message urgent and send 1 #
Request a return receipt and send 2 #
Mark message private and send 3 #
Set future delivery 4
Review recording 5
Re-record 6
Add to the message 7

While Listening to a Message

Rewind 1
Play previous message 1 4
Play next message 1 6
Pause or resume 2
Fast-forward 3
Fast-forward to end 3 3
Forward message 3 3 6
Delete message 3 3 7
Reply 3 3 8
Slow playback 4
Play message properties 5
Fast playback 6
Skip message, save as is #
Skip message, save as new # #
Cancel or back up *
Help 0

While Recording a Message, 
Name or Greeting

End a recording #
Pause or Resume 8

After Listening to a Message

Skip back 1
Play previous message 1 4
Play next message 1 6
Replay message 4
Play message properties 5
Forward message 6
Delete 7
Reply 8
Reply to all 8 2
Save as is #
Save or restore as new # #
Cancel or back up *
Help 0
 

Messages Button –
Dials the voicemail 
system.
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Setting Up Your Mailbox Voicemail Etiquette

• Press the Messages button on your phone.
• When prompted, enter the default voicemail PIN.

           

• Follow the prompts to record your name, greeting, change your 
voicemail PIN and to choose whether or not to be listed in 
directory assistance.

• Your voicemail PIN must be a minimum of 6 digits AND not be
the same as the previous 3 stored passwords.

Unified Messaging
Unity Connection Email Notifications

New voicemail messages are also sent directly to your Outlook inbox.  
From here, you can listen to, delete and manage your voice 
messages.

Jabber Voicemail Notifications

The voice messages tab lets you access, play and manage your 
voice messages.  Right-click voice messages to delete or call back.

• Record a greeting to add a personal touch.

A well-formed outgoing message includes:
� your name
� title
� school or department
� office hours (if applicable)
� when the caller can expect a reply

• Check your voicemail messages regularly.

• When you leave for the day or are away 
from your desk during the day, forward calls 
to your voicemail as a courtesy to callers.

• Record an “Out of Office” greeting if you will 
be unavailable for an extended period of 
time (vacation, illness, different hours 
temporarily). 

Include the dates/times you are unavailable.

Provide your callers with an alternate 
contact name/number in your absence.

• Reply, forward or delete messages 
immediately.  Keep your mailbox clean!

Voicemail Policy

• Messages can be up to 3 minutes in length.

• Voicemail inboxes can hold up to 100 
minutes of messages.

• Unread messages will stay in your mailbox 
until deleted.

• Unread messages that are deleted 
are retained for an additional 15 days before 
being permanently deleted.  
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WebEx
Quick Reference Guide
 

Home Screen Logging In
 1. Open a web browser and enter 

mymeeting.humber.ca
2. Enter your Humber email address and 

password.
3. Click Sign In.

First Time Use  
After logging in, follow the prompt to install 
Cisco WebEx Productivity Tools. 

1. Click Download Now.
2. Click Run.
3. Click Start WebEx Now.

Joining a Meeting Hosting a Meeting
Join from Meetings Page
1. Locate your meeting in the 

Today list.

Meetings scheduled for today 
are shown by default.  

To see meetings scheduled 
for another date, click the All 
Meetings tab.

2. Select the desired meeting.
3. If you are the meeting host, 

select Start.
4. If required, enter the meeting 

password and click Join.

Join by Meeting Number
1. From the Meetings page, select 

Join by Number.
2. Enter the meeting number.
3. If required, enter the meeting 

password and click Join.

Join from an Email Invitation
1. From your email application, open 

the meeting invitation.
2. Click Join the Meeting to join the 

meeting.
3. If prompted, sign in with your 

profile information.
4. If required, enter the meeting 

password and click Join.

Start an Instant Meeting
1. From the Meetings page, select Meet 

Now.
2. Enter your meeting details, including 

the names or email addresses of 
people you want to invite to your 
meeting.

3. Enter a meeting password.
4. Click Start.

Schedule a Meeting
1. From the Meetings page, select 

Schedule.
2. Enter details, date and length of 

meeting, reoccurrence and the names 
or email addresses of people you want 
to invite to your meeting.

3. Click Schedule It!
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Meeting Screen 

Passing Control to a Participant Recording a Session

To Make Someone a Presenter
• Drag the WebEx ball from the last presenter to the 

next presenter.
• If you are viewing participant thumbnails, mouse over 

a thumbnail and select Make Presenter.
• If you are sharing in full screen mode, mouse over 

the docked tray at the top of your screen, select 
Assign > Make Presenter then select a participant.

Make Someone Else the Host
• Right-click on a participant name or thumbnail then 

select Change Role to > Host.

Reclaim the Host Role
• Select your name in the Participant list then select 

Participant > Reclaim Host Role and enter the 
requested information.

Recording a meeting is a great way to share meeting content 
with invitees who could not make the meeting or with other 
interested people.

You can find links to the meetings you recorded on the 
Recordings page if you are also the meeting scheduler.

Sharing Content

File Sharing
File sharing is ideal for presenting information that you do not need to edit during the meeting, such as a video or slide 
presentation.  Participants can do the following:

• View shared files in their content viewers without the need for the application with which it was created.
• View a media file, such as a video, without the need for special software or hardware.

Application Sharing
When you share software, such as an application, during a meeting, it can be viewed from the participants’ content 
viewers or from a sharing window that opens on all participant screens.  In this window, you can show:

• An application (for example, you want to edit a document as a group or show your team how a tool works).
• Your computer desktop (for easily sharing several applications at once and for sharing file directories open on your 

computer).
• A web browser (useful for sharing particular Web pages with participants or showing a private intranet).
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Jabber
Quick Reference Guide

Screen
To Place a Call
• Enter the contact’s phone number in the 

Search or Call bar.
• Right-click over the contact’s name in 

your contact list.
• Select the Call icon in a chat window 

with the contact.

Incoming Calls
When you receive an incoming call, you can 
reply with a chat message, answer the call or 
decline the call.

Search
You can find, add and call contacts from the 
Search or Call bar.  Jabber can find 
contacts across the entire network as well as 
locally stored contacts.

Recent Calls and Voice Messages

The Recents tab shows a list of recent 
and missed calls.  

Hover your cursor over a missed call 
and select the Call icon to call back. 

Right-click on each item to delete it.

The Voice Messages tab lets 
you access, play and manage 
your voice messages.  

Right-click Voice Messages 
to delete or call back.
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Presence
 

Presence indicates a user’s availability and readiness 
to communicate.

• You can create up to three custom status messages for each availability 
state.

• Insert your cursor in the status message field and enter your new status 
message.

Collaboration
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Campus locations

Humber North Campus 
205 Humber College Blvd. 
Toronto, ON  M9W 5L7 
Canada

Humber Lakeshore Campus 
3199 Lake Shore Blvd. W. 
Toronto, ON  M8V 1K8 
Canada

Humber Orangeville Campus 
275 Alder St. 
Alder Street Recreation Complex 
Orangeville, ON  L9W 5H6 
Canada

humber.ca

Humber is a member 
of Polytechnics Canada

facebook.com/humbercollege

twitter.com/humbercollege

instagram.com/humbercollege

youtube.com/humberlive

pinterest.com/humbercollege

enquiry@humber.ca

http://facebook.com/humbercollege
http://twitter.com/humbercollege%20
http://instagram.com/humbercollege%20
http://youtube.com/humberlive%20
http://pinterest.com/humbercollege%20
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